Bradley University
College of Liberal Arts and Sciences
Department of Computer Sciences and Information Systems

CS591 Course: Software Project Management

Microsoft Office Project 2007:
Lab Manual



CS591 Course: Microsoft Project 2007 Lab Manual

1.

HOW TO START THE PROJECT ...eoueeeueeemreereesssessseesssesssesssssesssssssssessssessssssssssesssssssssesssssssssssssssessssesssssssssesssasees 4
11 Y =)0 Ve 0 1T P 4
1.2 Entering the Project Title ..ttt ss s st 5
1.3 Entering the Project Start Date....... e sessssssssessesssssssssssssssesssesssssssssssssssans 6
1.4 Project GUIAE WIZATd . ...ooueeeereemeereeesseeseessesmsesssessseesssssssssssessssssssesssesssesssessssessssssssssssesssesasesssessssssssesssssssessans 7

CREATING A BASIC WORK BREAKDOWN STRUCTURE (WBS) ..ccuerreemmeerseersesssssssssesssseesssessssesesanes 13
2.1 Entering the LiSt Of TASKS ..ot ssss s ssss s ssssss s sssees 13
2.2 Inserting a New Column on the Task Sheet..... s seees 14
2.3 Creating 2 UNiqUE WBS COAE ...vuueerreeeesseeereeesseessesseesssssssssessssesssssssssssssssssssssssssssssssssssssssssssssssssssssssnss 15
I D0 0L =) @ 04 Y e T 1= T TP 18
2.5 MaKING @ MIlESTONE ...ttt istiecs et esssesses s s s s bbb s e bbb s bbbt 19
2.6 Entering RECUITING TASKS ... eesssses e sssessssssssssssse s ssssssessssssssssessssssssasesssssssssssssesanees 19
2.7 Creating a Hierarchy Of TaSKS ... eeeisesesseessessesssesssssssesssssssssssssssssssssssssssssssssssssssssssssssssssass 21
2.8 (3 (3 1] 23

2.8.1 Enter the task NAME. ... ess s sssess s e ssssss s ssssnns 24

2.8.2 Creating WBS COIUMMN..... ettt sssse s sss s bbbt 25

2.8.3 Creating Hierarchy Of taSKS ... isesssssss s ssssssss s sssssssssssssssaees 26

2.8.4 Entering the duration of the tasK ... sesssssssssessssans 29

2.8.5 LOE= Y ool D =T 4 =V o PP 29

2.8.6 =T 000 g Q0 D - Yy o o PP 30

ADDING MORE DETAILS TO THE WBS.....ieeeieerseesseessseesssssssssssssessssssssssssssssssessssesssssssssesssssssssssssssesses 32
3.1 Assigning Predecessors t0 TaSKS ... ssesssssssssesssssssssesssessssssesssssssssssssssasees 32
3.2  Gantt Diagram with relationShips ... ssssssssssssenns 33
3.3  Network Diagram with relationships ... ssssssseesssesessnns 33
3.4  Setting Constraints 0N @ TaSK ...ttt sss st ess bbb pass s saees 34
3.5  Entering the Early Start and Early Finish Dates......conennenssneesesecsseesessessessesssesssesseseees 34

ADDING RESOURCES TO THE WBS.....oirirssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 37
4.1  Displaying the RESOUICE SHEEL ......oocreerecereenrersecreersessessseesseeesssssssss s st sesssssssssssssessssassssssssanes 37
4.2  ADDING RESOURCE ATTRIBUTES ....ccomeueeeerseressesssessssssssessssesssssssssssssssssssessssessssssssssssssssssssessssesssans 39
4.3 Entering MUltiple Pay RAtES ...t ssssesses s ssss bbb s sssans 40
4.4  Entering Equipment and Material RESOUICES.......coouremiuneeurieneeneeseiseessessessessessesssessssssessessssssessssans 41
4.5  Editing the RESOUICE CalENAar ......ocieireeereereeereiseseessreseesse e esssessss s sssesssesse s sssssssssessessssssesssesns 42
4.6 Dealing With Over Allocated RESOUICES ......ccriuerirmersreesresessssssesssessesssesssesssesssessssssssssssssssssssssssssssanes 45
4.7  LEVELING RESOURGCES.....cosieeetreeesseessessssesssessssesssssessssessssessssessssessssssssssesssssssssessssessssssssssssssssssssessssssssans 47
4.8 () 6 LY T P 47

481 Assigning Human and Material resources to tasks......eneensesesseessessessessessseenss 47

4.8.1.1 Enter the liSt 0f TESOUICES ... ———— 49
4.8.1.2 Entering Cost fOr aCh RESOUICE .....c.vvereemreereeeereeesseeseessessessseessessssssssssssesssssssssssssesssssssseess 49
4.8.1.3 Assigning each resource to the task ... ssesssesssesssseens 51
4.8.1.4  RESOUICE USAZE..cuieurieecureerrereesseessesseessesstsse s ssssss s sssse s ssse s sessss s bbb s bbbt 51
4.8.1.5 Dealing with over allocated RESOUICE.........oruereenrerneeneereeserseesseesee s ssessssseeans 52
4.8.1.6  LEVEIING RESOUICES ...ovevrreerereereemseeseessessessseessesssssssssessssssss s sssess s sssssssssssss s sssssssasssssssseses 54
4.8.2 Gantt Diagram with Resources ASSIZNed......coeeeneeenmeeneessseseessessessssssssessssssssssssesessans 57




CS591 Course: Microsoft Project 2007 Lab Manual

5

8

4.8.3 Network Diagram with Resources ASSIZNEd.......oeriennerneenneeneeseesecsseesessesssessssssssssssssasees 57
4.8.4 Assigning Resource AVailability ... sess s sssssssssssssanes 58
PRINTING AND FORMATTING THE PROJECT INFORMATION .....cconmerermrmermnsssssesssssssssssssessssesssessens 60
5.1  USING @ GANTT CHART ...oiiirnrrnsrisscsisssssssssssssssssssssssss s ssssssssssssssssssss s ssssssss s sssssssssssssssssssssssssssanes 60
5.2  Changing the Gridlines t0 D USEd ......oueeereenmremeemeeseerserseesseesseesssesseessesssssssssssssssssssssssssssssssssssssnss 61
5.3  Using the GANTT CHART WIZATd ...ocrieriencereeneineesseenseeseesesssessessssssessssssssssssesssssssssessssssesssssssssessssssssasees 62
53.1 Setting the Critical Pathi..... et 64
ST S 06 s U U= I o Y- o AP0 66
5.5  Displaying Task COMPIETION ...cucerermeereeeseeesessseessesseesssssesssesssssssssssssssssessssssssssssssssssssssssssssssssssssssssssass 67
5.6  Formatting the Progress Lines on the GANTT CHART .....ovceeeeneernmernneeseesssessessseesseeesessseesseeens 68
5.7 USING PredefiNed REPOITS ...t eesseesss e ssssssssss s s ssesssssssssessss s ssssssssssssanees 69
5.7.1 OVETVIEW REPOIT it ssssss s ssssss s ssss st st st sss s sanes 70
5.7.2 ASSIZNIMENT REPOTL coceerceieereeseceeeeseeseeseesse s sees e sssssssessses s ss st e s s s e ss s sssnes 72
5.8 Creating Custom REPOTLS .. ses 73
581 Selecting the REPOIT 0 USE .ocueeerceeeeeseerressesssess s sesssessssessessssssssssesssesssesssssssssssssssssssssessessaees 74
5.8.2 Defining NEW REPOTIT. .. iccereeereereiseeeee e essseesss e s sssss s s es bbb st 75
5.8.3 Defining Options for the RESOUICe REPOIT..... et eseesssesssssessees 76
ASSIGNING COST INFORMATION TO A TASK.ouiirinrrsisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 78
6.1 Determining PrOJECE COSE. . ssssessessssasees 78
6.2  Determining the BaSeliNe COST .....oeeerreeneeeesseesssssesssessssesssessssssessssessssssssssesssssssssssssssssssssssssssnss 79
6.3 Determining the COSt VATTANCE......oereeecereeseteesseesessseises et sessse s sessss s s s s s sssss s sanees 82
6.4  Determining the ACTUAL COStu. e sses s s s s s s sanes 82
6.5 Determining the RemMaining COStu ... ssssssssssessesssssssssssssssssssssssssssssssssssssans 83
TRACKING PROGRESS ....ooieeeeireeeemreesreeeseesseseesse s sssesssesssessssessssessssssss s s sssasssesssssssssssssessesssss s sssessssssssssseses 84
7.1  Planned Versus ACtUAl AMOUNTS ... mernesmiessessssssssssssess s sssssssssssss s sssssssssssssssssssssssssssssssnss 84
7.2 Tracking Project Percentage COMPLEtioN ... enereeneesseessessersesseesssssesssesesssesssessssssesssssssssssssesanees 86
7.3 Tracking the Actual HOUI'S WOTKEd ...ttt sssesess s sssessesssssesssesaees 87
74  Setting the BaSEINE ..ot sessses s st s s ss s s s s s st sssesssessssssnas 88
7.5  The Tracking GANTT CHART ..o seesseesseesseesssssesssessssessssssssssssssssesssssssssssssssesssessssssssessssssssssass 90
7.6 Interrupting Work 0N @ tASK ...t eeset s sees e bbb s s 91
2 (=) (=) o (ol 92

Page 3



CS591 Course: Microsoft Project 2007 Lab Manual

1. HOW TO START THE PROJECT

1.1 Starting Project

In order to start Microsoft Project 2007 in CS/IS labs, click the Windows Start menu item (in the
left lower corner of computer screen), then click All Programs menu item, select Microsoft
Applications menu item, and click on Microsoft Project 2007 icon. You should get the main window
of Project 2007, as shown below

Tvpe a question for help

Tools Project  Report  Collaborate  Window — Help

£ - | == @ == B | @ T s @ 4k == Show~ | arial - - B I O | u= £
: A= ||Tasks - | Resources ~ | Track ~ | Repork - _

=) Task Mame Covslng Dalay 10 Ot =, 0 Oot a0, 10 Octi7, 10 Ot 24,10 Oot =1, 10 Mo 7,10 A

i WWIT [F (S (S[MITWIT[F[S[S[M[TWI[T[F[S[5[M[TW[T[F[S|5[M[T W[ T[F[5[5[M[TW[T[F[S[S[M[T[¥
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1.2 Entering the Project Title

To enter a title for a project, navigate to File-> Properties. As shown below. Enter project title,
Author & company.

w  Insert Format  Tools  Project  Report  Collsborate  Window  Help Type a question for help + & X

ctrlr P % 4 = show~ | Arial =g Zdlwr o oaye o o]
Chrl+o
Ctrl+s Duration Start £ 0 Sct10,10 Cot17, 10 Cot 24, 10 ~
WM T [ [T [F[S[S[M[T W T[F[S|S[M[TW[T[F[S S [M[TW[T[F[S |
dis Save Workspace...
fo
Save For Sharing
De Page Setup. ..
Do Prink Preview
Lis
dSa Erink... Chrlp
on
Sel Send Ta >
Lin Properties
L e OFFl
o wark OFFline
inf; 1 D3\ \MS_Bradley!sem_3\UskoviMSProject_2007_tutorial
Se
tas Exit

Identify risks to the project i —
Add docurnents to the project I

Publish project information to [
the web

After planning your tasks, you
can go to the Resources area [
to build your project's tearmn
and assign people to tasks.

Edit  Miew Imsert Format  Tools  Project  Report  Collsborate  Window  Help Type a question for help = & X
W@ % 4 = show~ Arial -8 ~| B Fr U | ;‘
| General | Surnmary | Statistics || Contents || Customi
@@Ta - Duration Start 13,10 Cct 10,410 et 17,10 Cct 24,10
Title: |ReddvsG.r'DcerSf | MITWT[F[S[SIM[TWIT[F[S[S[M[TWIT[F[S[SM[TW[T[F]S
Plan an 3
project Subject: | |
itern b
display Author: |Sravanthi |
for corr
Managet: | |
Defi
i !ne Company: |Erad|ey University |
Define
ek th.e Category: | |
organig
Schedy Keywords: | |
!‘i”k i Comments:
infarm4
Add col
inform4
Hyperlink |
Set ded base:
tasks
Identif
Add do [[]5ave preview picture
Publish

the Wwe

After plaTNg voUr toeRs, voo

can go to the Resources area -
to build your project's tearm

and assign people to tasks,
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1.3 Entering the Project Start Date

To set a start date for the project. Navigate to Project ->Project Information

osoft Pro

File Edit View Insert Format  Tools | Project port: llsborate  Window  Help Type a question for help = & X
= [ 3 ) - - Soik > - - | Arial -8 - = 5
= = N " . P> + Show B 7 U | B
{5 Tasks - | Resources = | Track - | Repo Bilinrod fori e Tastis 4
Group byt Mo Group 3
@ D Tasks Qutline ¥ Fon Start 3,10 Cctio, 10 Ccti7, 10 Oct 24, 10
WES y L M TR TIF[S[SM[TM[TIF[S[sM[TW[T[F[S|SM[TW[T[F[S —
Plan and schedule your = I —
project's tasks by clicking an Task Information...  Shift+F2
itern below, Slicking an itern 2
displays tools and instructions .| TaskmMotes...
for cornpleting that step., — -
BSiing B 422, Task Drivers

Define the project

Define general working times
List the tasks in the project
Grganize tasks into phases
Schedule tasks

Link to or attach more task
information

Add columns of custom
inforrmation

Set deadlines and constrain
tasks

Identify risks to the project
Add docurnents to the project

Publish project information to
the Wweb

After planning your tasks, you
can go to the Resources area
to build your project's team
and assign peopls to tasks.

Project Information. . .

Eile Edit View Insert Format  Tools  Project  Report  Collsborate  Window  Help Type a question for help = @ X

D el 0 | Ga@ 9 - hE- MR A== % 4 — show- | Arial -8 - B I O = i
i[5 | [tasks| - | Resources ~ | Track =~ | Report = 9

'@ @ Tasks TESE RS Duration Start T3, 0 oct10, 10 oct17, 10 Cct 24, 10 -~

M T TIF[s[SM[TWTIF[s[sM[TMW[T[F[S|SM[TW[T[F[S —

Plan and schedule your
project's tasks by clicking an
itern below, Clicking an itsm
displays tools and instructions
for completing that step.

Define the project
Define general waorking tirnes
List the tasks in the project

Grganize tasks into phases
Schedule tasks

Link to or attach rmore task
inforrmation

add columns of custam
information

Set deadlines and constrain
tasks

Identify risks ta the projsct

Add documents to the project

Publish praject information to
the Wweb

after planning your tasks, you
can go to the Resources area
to build your praject's tearmn

and assign people to tasks.

Start date:

Current date:  |Mon 10/11/10

Einish date:

Schedule From:

All tasks begin

17 18 19 20 21 22 23

E.nterprlse Custom Fields| 2 50 52 5755 54 139

[ 1
| Custam Field Name

[ Help | [ staistics... |

31 5

Status date:  |MA
Calendar: | standard
Eririty: SO0 &

-

Ok Cancel

Page 6
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1.4 Project Guide Wizard

To get the project guide Click on View -> Turn on Project Guide

g Eile  Edit | Miew | Insert  Formak  Tools  Projeck  Repork  Collsborate Window  Help Type a guestion for help -
i) B3 bl Calendar == g8 4 | @ H % 4+ — show~- | Arial 8 ~| B I U |w= B
«  Gantt Chart
1 Metwork Diagrarn [ stert Oct 3,10 Oct 10,10 oot 17,10 Oct 24,10 Oct 51,10 |
| | TlF[s[smTMm[T[F[s|[sM[Tw[T[F[s|s[m[Tw[T[F[s[smM[T[T[F[s[s[m[TwW[T[F[s|5[ =

i Task Usage

Tracking Gantt
Resource Graph
Resource Sheet

Resource Usage

More Views. ..
Table: Entry »
Toolbars (3

Turn On Project Guide
Wiew Bar

Hide Change Highlighting

Header and Footer...

Zoom...

———
‘4 start L
& Microsoft Project - Project1
@ Eile  Edit  Miew Insert  Formak  Tools  Projeck  Repork  Collsborate  Window  Help Type a question for help - F
PN D @98 % 4 = Show~ | Arial ~8 | B 7 U= ;d
» a Task Name Duration Start Cct 3,10 act 10,10 Oct 17,10 Oct 24,10 ”~
Pyl | | sSM[TPw[T[FIs|sM[TWwW[TIF[S|S[M[T[W[T[F[s|[S[M[T[wW[T[F —

Plan and schedule your project's
tasks by clicking an item below,
Glicking an item displays tools and
instructions for completing that
step, |

Define the praject
Define general working times
Lizst the tazks in the project
Organize tasks into phases
Schedule tasks E—

Link ta ar arrach more task I
infarmation

Add columns of custam informarion
Set deadlines and constrain tasks
Identify risks to the project

Add documents to the project —

Publish project information to the I
web

After planning vour tazks, you can
g0 to the Resources area to build
your project's team and assign
people to tazks, —
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To get the project guide toolbar Click on View-> Toolbars-> Project Guide or right-click anywhere in

the toolbar area at the top of the screen and choose Project Guide.
B Microsoft Project - Project1

@ File Edit View Insert Format Tools Project  Report  Collsborate  Window  Help Type a question for help = & X
R =™ W - - RS IR W= SRR I S T S wie Sl T "
v Standard
@D D Tasks 3 © | TaskName [iE M Frrmatting Gt A0, 0 Ot 17,0 Ot 24,10 ]
| | Collaborate [TIFlslsM[TW[T[F[S[sM[TW[T[F[S[S[M[T [W[TI[F
Plan and schedule your project's 1:[ —
tasks by clicking an item belaw, L | 4] T S
Clicking an item displays tools and
instructions far completing that [ [ I Drawing
step,

Resource Management
Define the project

Tracking
Define general working times
List the tasks in the project F =T Wisual Basic
rganize tasks into phases — T Web
Schedule tasks T
Analysis

Link to or sttach more task

infarmatian Compare Project Yersions

Add columns of custem information
Metwark Diagram
Set deadlines and constrain tasks

Tdentify rizks to the project PERT Analysis

Add documents ta the project Project Guide

Publish project information to the - — .
Web | Custamize. ..

After planning your tasks, you can
go to the Resources area to build
wour project's team and assign
people to tasks,

When you click a link in the Project Guide, a wizard starts and walks you through the process that’s
suggested by the link. For example, if you click the Tasks button on the Project Guide toolbar and
then click the Define the project link, a three-step wizard walks you through starting a project.

Page 8
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EZf] File Edit  Wiew Insert  Format  Tools  Project  Report  Collsborate  Window  Help Type a question far help = & X
= W - SR S R - i o 4 = Show~ | Arial -8 - | B I U |w= B

=] | Tasks - Resources ~ | Track ~  Report - B

@ @ Define the Project

|6 |TaSkName |Duratinn | Start Qct 10,0 Oct17,'0 Oct 24,10 ODt31,'A..
TIF[EsM[TW[T[F[s|[SM[TW[T[F[s[SM[TW[T[F[S[S[M[T

Enter project i

This wizard helps you get started
with your project.

Enter the estimated date your
project will begin:

oAz B

ctober,
Tue fitied Thu
77 78 0 Tz
3 4 5 B8 7 8 @4 =
o1 12 4EE 14 15 18 |
1To1s 19 20 3 o2 I
24 35 26 27 28 29 30

+ 107972010

Steplof3 Pe
& Continue to Step 2 =
| |8 (| - [

Ready

File Edit Wiew Insert Format  Tools  Broject  Report  Collsborate  Wwindow  Help Type a guestion for help = & X

P R Al - s s R @ E P 4+ — show- | Arial +8 | B r O |v 2
[El | Tasks = Resources ~ | Track =~  Report = &

Define the Project @  |Taskilame | Duration | Start Gct 10,10 et 17,10 et 24,10 Cct 3l A

TIF[S[SM[TW[T[F[S[SIM[TW[T[F[S|S[M[TWIT[F[S|S[M][T

entdForward |information

This wizard helps you get started
with your project,

Enter the estimated date your —
project will begin:

Mofazoi0 =

Step1of3 iR
= Continue to Step 2 —
| (i) (i >z

Ready

Page 9
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(hzl] Fle Edit  wview Insert Format Tools Project  Report  Collsborate  Window  Help Type a guestion for help = @ X
PN EEH &L G -8 sl R @ Zi% % 4 = show- | arl -8 ~| B I U|¥ =

i Tasks ~ Resources + | Track + | Report  ~ B

o |Task MName | Druration | Start Qct 10,0 Oct17,'0 Oct 24,10 Oct 31 2 A.

e
el I TIF[E S M T W T F B M T T F S S M T W T [SIMIT =

Ilab on your project

Project Server and Project Web
Access allow vou and your team
members to view and update
project information from 2 Web
site, Do you want to use Project —
Server and Project Web Access?

) wes
& Mo

To setup Project Server |ater,
choosz Prepare to track the
progress of your project from the
Track goal ares in the Project
Guide Bar.

Step 20f 3
¢ Continue to Step 3
48 Go backto Step 1

|~
2
A
%

Ready

i@ File Edit ‘Wiew Insert Format Tools Project  Report  Collsborate  Window  Help Type aguestion for help = & %
N EH S0 RR9-0-0 =528 @ Ziw 9 & = sow- | 38 BB L U|v i

E Tasks - Resources = | Track = | Report - s

|g |Task Narme | Duration | Start Oct 10,'10 Oct 17,10 Oct 24,10 Octal, A

= % % :
(@iZDefine the Project SIMTW[T[F[S[SM[T[W[T[F[S|SM[TW[T[F[S[S[M[T -

_.
=
7]

Enter additional information

Mow wou're ready to startfilling in
the details of your project, Click
Save and Finish below and follow
the topics in this sidepane to
begin,

Step3of3
© save and Finish
4 Gobackto Step2

Ready
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If you click the Resources button on the Project Guide taskbar and then click Specify people and
equipment for the project, the Project Guide helps you set up resources for your project

& Microsoft Pro

SEZH] Eile  Edit  wiew Insert Format  Tools  Project  Report  Collaborate  window  Help Type a question for help = & X
= W - N - R = ga = B

: 0 Tasks ~ Resources + | Track + | Report  ~ B

P % % = Show=- | Arial -8 ~| B r U |w

@ @ Resources =

Build your project's team and
azzign people to tasks by clicking
an item below. Clicking an item
dizplays tocls and instructions far
completing that step.

I Oct 10,0 Octi7, 0 Oct 24, 10 Oct 31, '~
ITIF[s|sM[TWIT[Fs[s[M[T W[T[F[S|S[M[T[W[T[F[s[S[M[T =

o |Task Mame | Duration | Start

Specify penple and far
the project

Specify the booking types for
resources

Define warking times far razaurcas
Assign people and equipment to
tasks

Link to or attach more resource
infarmation

Add columns of custarn informatian

Publish project information to the
web

After entering task and resource
information, you can go to the
Track areate track and manags
your project as it progresses.

Ready

@ File Edit ‘ew Insett Format  Tools  Project  Report  Collaborate  Window  Help Typs & question for help (g IGE
A = W RN R A IR - NN A=A Zis 9 &~ show- | Arial -6 «| B I U|v= :
=] | Tasks - Resources ~ | Track -~  Report - s
@ @speﬁf.y Resources = = !ﬂ | Resource Name | Er_n Address | Windows User Account , Group | Standard Rete | Overtime Rete
1 Dr Uskow $0.00mr $0.00mr =
Do you want to: e T
2 T
() Add razaurcas from Projact = Sravanthi | | | | $0.00Ar| 30,00
Server 3 Shashi $0.00Mhr 50.00Mr
() Add resources from the re Diawiel 3000 F0.00r
company Address Book - - | | | I |
) Add resourcas from the L5 Mick | | | | $0.00r | $0.00mr
company directory 5] Erick $0.00mr $0.00mr
) Enterresources manually T Alex $0.00mr $0.00mr
Bone "8. Greg $0.00Mr $0.00mr
g Mark $0.00Mhr $0.00Mr

— 1
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When you click the Track button on the Project Guide toolbar, you can perform a variety of tasks
that are associated with tracking your project, including setting a baseline

rosoft Project - Proje,

SEZH] Ele  Edit  Wiew Insert  Format  Tools  Project  Report  Collaborate  Wwindow  Help Type a question for help = @ X
N EH &R G- e e ga S| @ _a # & + = Show-~ | Aral sia x| B r O |w ]
: 15 Tasks ~  Resources ~ | Track - | Report - =
D D reack = > %
Uskow
Track and manage your project as =
it progresses by clicking an itam Sravarthi
below. Clicking an item displays 1 1 1 1 1
tools and instructions for al Shssh $0.00mr SCLOm
campleting that step. | David $0.00mr $0.00mr |
Nick $0.00mr $0.00mr |
Save a baseline plan to compare L) | | | | | |
with latar versions Erick $0.00mr $0.00mr |
Prepare to track the progress of | Blenc F0.00Mr $0.00Ar |
e 1 | | | | | |
HotbRIales Greg $0.00r F0.00Mr |
Incorporate prograss information = |
i E e Mark $0.00mr $0.00mr
Check the progress of the project I 1
Malterchanges tathe projact [ "
See what is driving the stare date
of a task
Track risks and issues associated
with this project
Requesttant-based status reparts
Publish project information to the
Weh
To look at different wiews and
reparts of project information, you
can gota the Report area.
v
= |
| ¥ _z

Ready

Page 12
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2 CREATING A BASIC WORK BREAKDOWN STRUCTURE (WBS)
2.1 Entering the List of Tasks

When you click the Task button on the Project Guide toolbar, you can enter the List of Task for your

project.

B Microsoft Project - Project1

Eile Edit View Insert Format  Tools Project  Report  Collsborate  Window  Help Type a question for help = & X
s =~ - Y B9 8 = Ea =

I=] | |Tasks =~ Resources =~ | Track =~ | Report = &

L i @ 4 = show- | Arial '8 | B r W |w= ;:

@ @ List Tasks > Task Mame | Work | % \Work Complete | Duration Start Oct 10, oct 17,

10 7.0 Ot 24,110
TIF[S|SM[TW[T[F[S|S[M[T [W][T[F[S|[S[M[T [W[T[F[S

1 : ' 1

Enter tashs...

List your project's tasks, Use
unigue descriptive task names,
In the Duratien column, enter the
time required to complete each
task, as a number followed by
‘hours', 'days' ar 'months'. Don't
enter start and finizh dates yer.
The Project Suide will help vou
schedule tasks later,

o Hine

Import tasks from Escel

Import wizard...

Indicate milestones

Mark tasks that reprasent major
suents in the project as
milestones, The symbol
indicates a milestone,
[] Maks selected task
milestons
Cone

@) More Information

¥
3
%

Ready
‘4 start LN s

B Microsoft Project - MSProject_2007_tutorial

‘iz File  Edit  Wiew Insert Format  Tools  Project  Report  Collaborate  Windew  Help Type a question for help
=A™ I NN - R AR - SN RE=N- ] & % 4+ — Show- | Arisl -8 -|B I U|v £
D5 Tasks - | Resources - | Track - | Report < _
Begin Project
i > Task Mame Duration Start Finizh 2ct 10,10 oct17,10 ~
@ @List Tasks S S[M|TW[T[F[S|S[M[T [T
Enter tasks... Begin Project I odays wed10M3M0  wed 1013510 & 1013 N
Lt e preiees Eals, Uss Product Research 4days| Wed 10M3M0  hion 104840 Y
unigue descriptive task Irterview Developers Odays| Wed 10M3M0 Wed 104340 & 1013
narnes. Review Product Specific: 1day Wed 101340 wWed 104310 [E
In the Duration column, -
enter the time required to Research Competition 4 days Wed 101310 hon 10MSHM0 [LECRN S——
cornplete each task, as a Wirite Procluct Overview 1day Wed 10M3A0  Wed 101340 [T
mumRECHP FEIPGICE) (5 TR, Brochure Design 11 days| WWed 10A3A0 Wed 10027410 [ RRSS—
days' or 'months'. Don't enter -
start and finish dates yet. The Wirite Copy from Overvier 3 days| Wed 1041310 Fri 10/ 5M0 % Ol
Project Guide will help you Story Board Design 4days| Wed 10A3A0  Maon 1048A0 % e
schedule tasks later.
7 Product Photo Session 1day Wed 10A3M0  Wed 104340 [T
gy Design spproval 1day| Ved 10M3M0 vWed 104340 [
Import tasks from Excel Create Final Design Sdays| Wed 101310 Fri 10415410 0 e
Import wizard... Virite Customer Documen 525 days| wWed 10/ 310 hon 10i25/0 R —
Indicate milestones - Press Coverage 8.5 days  Wed 104310 Mon 10/25/10 [ —
A S—— wirite Press Releases Zdays| Wed 101310 Thu 1014010 0% !
major events in the project as Prepare hedia kit 6days Wed 10A3100 Wed 1020010 L —]
milestanss. The symbal Press Mailing 05 days, Wed 1013410 Wed 1043M0 0% :
indicates a rilestone. 1013
St oo Gk & Press Conference Odays| Wed 10A3A0  Wed 104340 + :
milestone Print Collsteral 11 days ) Wed 10/13M0  Wed 10/27M0 [LECI s—)
Done - Advertising 1day Wed 10/1310 Wed 10/13/10 0% @@
® More Information Presert & 1day | Wed 10A300  Wed 1043010 [T




CS591 Course: Microsoft Project 2007 Lab Manual

2.2 Inserting a New Column on the Task Sheet
Select Insert->Column->WBS and then click OK.

Mew Task

7
=] Project...

Column...

@ @ List Tasks

Enter tasks

Pags Break
List your project's ta

unique descriptive ta| 43 Drawing
names.
In the Duration coly ElflE000

enter the time reguir] Hyperlink. ..
complete sach task, 2 -

Mew Resource From

Recurring Task. .. p—

nurber follawed by ‘hours',
‘days' or 'months’. Don't enter
start and finish dates yet. The
Project Guide will help you
schedule tasks later.

o Hirt

Import tasks from Excel

Import wizard...

Indicate milestones

Mark tasks that represent
rajor events in the project as
rmilestanes. The symbal
indicates a milestone.

Make selected task a
milestone

Crone

@ More Information

Collsborate  Wwindow Type a question for help [+ [ @ X
Lo = E@ @ L2i% % 4 = show- | Al -8 -~ | B I U w= =
sk Mame Duration Start Finish Oct 10,0 Qct17,10 ~
S S[M[TW[T[F[s[S[M[TW[T[ -
roject | Odays| wed 101310  Ved 10A310 @ 1013 b
-t Research T 4days| Wed 10310 Mon 10/810 [N
Developers Ddays| Wed 10M3A10  Wed 104310 & 1013
Proguct Specifice 1day| Wed 10/13M10  wed 104310 L= '
Chripk [N Competition 4 days| Wed 10M3M0 Mon 10M8M0 0 —
ouct Crverview 1 day| WWed 10M3M0 Wed 104310 [0 :
Brachure Design 11 days| Wwed 10M3A0 VWed 1027410 LS —
Wit Copy from Owerviss 3days| Wed 10AM3M0  Fri10A5A0 %
Story Board Design 4days| Wed 10/13M0  Mon 10810 [
Product Photo Session 1day| Wed 10/13M10  wed 104310 L=
Design approval 1day| Wed 10/13M10  wed 104310 L=
Create Final Design 3days| Wed 10M3M0 Fri10ASA0 %
Wirite Customer Documen| 625 days | Wed 10/3A0  Mon 10025410 LS —
- Press Coverage 8.5 days = Wed 101310 Mon 10/2510 e —]
Wirite Press Releases 2 days| Wed 10M3M0  Thu 104410 0% :
Prepare Media Wit Bdays| Wed 10/13M10  Wed 10520410 [LECR s—
Press Mailing 0.5 days| Wed 1013410 Wed 101310 % g :
Press Conference Ddays| Wed 10A3A10  Wed 104310 & 1013
Print Collteral 11 days| wed 10M3M0 Wed 1027410 [ ——
- Advertising 1day Wed 104310 Wed 1011310 @
Present & 1 day| WWed 10M3M0 Wed 104310 LT

(2
A

Ready

@ File Edit W¥iew Insert  Format

Tools Project  Report  Collaborate

Window  Help

Type a question for help = @ X

. = e ~ ) c =
£ . 3 B3 [ - e . =" ¢ - - | arial ~ 8 - = =
NS H &3 RR9-¢- @ i P+ = show B 7 U/ 2]
(5] | Tasks ~ Resources - | Track - | Report = =
Begin Project
List Tasks b4 Task MName Duration Start Finizh Dct10,'10 Oct17, 10 -~

e SIS TMIT WITIFIS (S [MIT W T]

Entertasken: Odays Wed 10M3M0 Wed 10310 & 1013 T

List your project's tasks. Use Product Research 4 days| Wed 10M3M0  Mon 1048M0| 0% _

unigue descriptive task Interview Developers Odays| ‘ed 10310 Wed 104340 $ 1013

names. Review Praduct Specifics 1 cay| Wed 10A3H0 WWed 104310 o @@

In the Duration column, T |

anter the time reguired to Resesarch Competition 4 days| Wed 10M13M0  Mon 10A8/0 0%

cornplete each task, as a Wirite Product Overviesy 1 day Wed 101310 Wed 104340 h g

bl oy ot Brochure Design 11 days| Wed 101310 Wed 1002710

'days' or 'months', Don't enter
start and finish dates yet. The
Project Guide will help you
schedule tasks later,

o it

Import tasks from Excel

Import wizard...

Indicate milestones

Mark tasks that represent
major events in the project as
milestanes. The symbal *
indicates a milestone.

Make selected task a
milestone

Done

@9 Mare Information

Wirite Copy from
Story Board Desi

Design approval | Title:
Create Final Desi
‘Write Customer D
- Press Covera
Wirite Press Rele

Align title:
Align data:
width:

Prepare Media Kit
Press Mailing

Product Photo Sef Field name:

Unigue ID

Unique ID Predecessars
Unique ID Successaors
Update MNeeded

WAC

WBS Predecessors

0%

[
[
0% C—
0%

BestFit | [

O |

L

—
L

=
=——————————

[ cancal ]

Press Conference
Prirt Collateral

- Advertising
Present &d

0 days

11 days

1 day
1 day

Wed 101310
Wigd 101310
Wed 101310
Wed 101310

Wed 1013010
Wed 10027410 |
Wed 1011310

Wwed 10300 |
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H i.g] Eile Edit Miew Insert Formak  Tools  Projeck  Report  Collsborate  Window  Help Type a question for help
I EH &R Gl -8 =R R @ 2l @ 4+ = show=- | Arial -8 | B I U |w=
=] |/ Tasks - Resources ~ | Track =~  Report = el

Beqgin Project

List Tasks o Task Mame Duration Start Finish | cct10,'10 Oct17, 10 A
@® B - SIEM[TW[TIFIS[SM[T WT] |
Entectasks.. Odays Wed 10M310  Wed 1013510 & 1013 i
List your project's tasks. Uss Product Research 4days| Wed 1071310 Mon 104840 0% —
unique descriptive task Interview Developers Odays Wed 101310 Wed 10413410 4 1013
namss. Feviern: Product Speific: 1y Wed 10A3A0 Wed 1043410 o @
In the Duration column, - 1
enter the time required to Research Competition 4 days| Wed 10M3M0 kon 104 SMD: 1%
complete each task, as a Wirite Product Overview 1 day | Wed 10/13M0 0 Wed 101310 [ ] =
!“d“"”b.Er tollomeribyshionrg Brochure Design 11 days| Wed 1043H0  Wed 1002710 | [ —
ays' or 'months'. Don't enter .
start and finish dates yet. The Wirite: Copy from LR
Project Guide will help you 0% _
schedule tasks later, S .
g Product Photo Sed Field name: o @
Hint Design approval | Title: | | "o @
Import tasks from Excel Create Final Desi align e |Centsr "l [ — :
Import wizard... Wirite Customer D) . Ll ]
p = = Align data: | Right v| o :
Indicate milestones £ Prees Cowara e —
Wite P Rel Width: 10 - Header Text Wrapping 0% i
Mark tasks that represent & Press Rele [—]
major events in the project as . 0%
IJ 1 Th Tj IJ. Frenale Metia iy [ Best Fit ] [ (514 ] [ Zancel ] .
miestones, hhe Yoo Press Mailing L]
indicates a milestone. -
Maike selactad task o Press Conference Odays| Wed 1013010 WWed 101310 & 1013 :
milestane Print Collateral 11 days | Wed 1071340 Wed 1002710 [LECT S—
Done - Advertising 1day | Wed 101310 Wed 1011310 % g
@ More infarmation Present Ad 1day | Wed 10340 Wed 104340 [

Eile Edit diew Insert Format  Iools | Projeck | Beport  Collaborate Help Type a question for help |+ & X
== =N N IR St 4 = Show ~ | arial -5 - | B 7 U |v= 7]
i3 | ltasks| - | Resources + | Track - | Repol Biltered for: All Tasks >
A Group by: Mo Group »
@ @ List Tasks =< Outline * Htion Start Finish Oct 10,10 Oct7, 0 Cct 24,10 A
5 TIF[S (S [M[T T [F[S = [M[T[w[T[F[S|[M[T "
wBs » Define Code. ..
Emier fer e = o 10310 & 1013 -
Task Information...  Shift+Fz2 Renumber. ..
List your project's tasks. Use b - n 1011840 b —— ]
unique deseriptive task Task Motes. .. days| Wed 10M 310 Wed 104310 & 1013
narnes. 2 Tack Drivers 1day| Wed10M3M0 wed 10M3A0 % @m
In the Duration column, =
enter the Hme required to v ——— days| Wed 10310 han 104810 %
comnplete sach task, as a 1 ey Wied 10A3M0 Wed 10M3H0 0% @@
nurnber follawed by ‘hours’, 7 Brochure Design 11 deys| Wed 10M3M0 wWed 102710 0% s
days' or 'months'. Don't enter
start and finish dates yet. The 3 Wirite Copy from Crvervies Fdays| Wed 104340 Fri 10450 0%
Project Guide will help you 3| Story Board Design 4days| Wed 10A3A0]  Man 10A 60 %
scheduls tasks later.
P e 10| Product Phota Session 1day | Wied 10A 310 Wwed 101310 o @@
(HnE 11|  Design approval 1day ed 10M340 wed 1013M0 o G
Import tasks from Excel 12| Create Final Design 3days Wed 104340 Fri10A5M0 0%
Irnport wizard... 13| Wirite Customer Documen| 8,25 deys | Wied 10/ 340 Mon 10/2510 0
Indicate milestones 14| - Press Coverage 8.5 days  Wed 1011310 Mon 1025110 % D
Mark tasks that represent 15| Atite Press Releasas 2 days| Wed 10340 Thu10M4M0 [
rnajor svents in the prnje.ct as 16 Prepare Media Kit Bdays Wed 10M13M10 Wed 10/20/10 LU —
milestones. The symbol 17| Press Mailng 05 days| WWed 101310 wed 1013A0 o @
indicates a milestone. 10113
s el er] e o 18|  Press Confersnce 0days| Wed 10340 Wad 104 3M0 &
LA e 18| Print Collsteral 1 days| Wied 10A 340 VWed 10727710 LR — e —)
Done 20 - Advertising 1day| Wed 101310 Wed 10/3/10 o @@
@ More Information 21| Present Ad 1day | Wed 10M3M0 Wed 101310 [
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@ File Edit Wiew Insert Formak  Tools  Projectk  Report Collsborate Window  Help Type a guestion for help - 8 X
== W RN R AR NN Hi==F ! Zie % & = show- | rial 20 sliearanisr :
([ | Tasks - Resources ~ | Track ~+ | Report - B
1
List Tasks $% | WHE | Task Mame | Curation | Start Finish Oct 10,10 Oct 17,10 ot 24,10 A |
oo as L TIF[S|5[M[T [T [F[S 5[M[T [T [F[5 |5 [MITW
EriEtaake.., d R Doays wied 1030 Wed 100340 & 1013 Tl
T T E 2| Product Research 4days| Wed 10M3A0 Mon 10MEA0 0% G
unigue descriptive task 3 3 Irterview Developers 0 days| Wed 10M3M0 0 Wed 1013410 4 1013
names. 4 4| 4 L = 0% @@
In the Duration column, = 5 0%
enter the time required to )|  S——
cornplete each task, as a B ] i 0% @R
number follawed by ‘hours?, s | | | s
‘days' or 'months', Don't enter 4% Profect Code Prefix: ——————ee
start and finish dates yet. The g & : = | ‘ LECRE s
Project Guide will help you g T § [
e R 9 9. Code mask (excluding prefix):
: 10 10| | [l % @@
o Hint 11 11 Level | Sequence Length | Separator [
Import tasks from Excel 12 12 | [ : 0%
Import wizard... 13 13 || : L ————————————————
= = Uppercase Letters (ordered) ; o ;
i i O ————
Indicate milestones = | |Lowercase Letters (ordered)
Mark tasks that represent 1= 15 haractars (inordared) 0% C—
major events in the project as g 16 T 2] LELR — |
milestones. The symbal 17 17 Generate WES code For new t 0% g
indicates a rnilestone. — i = e SN
Malks selettad tasica e 18 iy uniqueness of niew WES &
milestone 18 19 LI
Dore |20 20 E. e % @
@ More Inforrmation i 21 Present &d 1 day | Wed 10M 310 Wied 101 3M0 0 gm

File Edit ‘iew Insert Format  Tools  Project  Report  Collsborate  Window  Help Type a guestion for help = & X
= W RN - S R A - NN = Zi% % & = show- | arial -8 - B I U= B
i[5 |Tasks - Resources ~ | Track =~ | Report = B

1
5 P WES | Task Mame Duration Start | Finizh ©ct 10,'10 Oct17,'10 Oct 24,110 A |
Sieiicliads ”| TIFS (S MIT WIT[F 55 M7 WIT[F[E[5[MTW
Enteritaske.. " R c:onrroiect Odays| Wed 104310 Ved 10/ 310 & 1043 0
S P e e i T 2 2| Product Research ddays Wed 101300 hon 101810 0%
unigue descriptive task i 3 Interview Developers Odays ‘Wed 101310 Wed 1011310 § 1013
names. i | = = = [,
In the Duration column, = = o
enter the time required to Ll O]
complete each task, as a B ] b 0% gl
numnber followed by 'hours’, = g [ [ | s
‘days' or 'months’. Don't enter ki 1 project Code prefix: e ————
start and finish dates yet. The ] 8 ) % | ‘ 0% (O
Project Guide will help you =B al . [
Al S Code mask {excluding prefix):
i 10 10 x| any L=
Hint 11 11 L Sequence | Length Separator o @@
Import tasks from Excel 1z | | L Mumbers {ordered) B . %
| ~
Impart wizard... 13 i = LL———— ]
Indicate milestones 12 2 il Ly
Mark tasks that represant 15 15 3, 0% —
major events in the project as 16 16 ; ] " —
milestonses, The symbaol 17 17 Generate WES code For new task 0% @
indicates a rilestons. = e : e 8 -
18 erify unigueness of new codes
Make selected task a E S % = 2
Gone 20 20 =B % @@
& Viore Thfarmmation 21 21| Presert &4 T day| wved 10300 wed 107300 LI
2

Enter the code Prefix as ggg as shown below
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:i@ File Edit ‘“iew Insert Format Tools Project  Report  Collsborate  Window  Help Type a question for help (= &
=" e - R el R Mi==F: ¥ & & = show~ | Aridl -8 -|B I U|va g
s E ‘Tasks ~ Resources ~  Track =  Report - s
i ]
List Tasks = WES | Task Mame | Duration Start Firish Oct 10,'10 Oct17,"10 Oct 24,10 A
o as | TIF IS [S[MIT WIT[F5(S [MT T [F IS [S[MITW =
Enter tasks... Bedin Project Ddays Wed 101310 Wed 1011310 & 1013 T
e e e 2 Product Research 4days| Wed 101340 Mon 104810 0% G
unigue descriptive task 3| Interview Developers Odays Wed 101340 Wed 1041340 & 1013
names. 7 2 = @
In the Duration column, A %
enter the time required to  Som—————
cornplete each task, as a 5 ; LECa o]
nurnber followed by 'hours', 7' Code preview !gggl.l.l ‘ 0%
R eh e e L —
St A Fin e ot et The g ! = L ‘ [
Project Guide will help you g i i %
i c Code mask (excluding prefix):
\) : 10 | Mumbers {ordered) LEC =]
Hirt: 11 Level | Sequence | Length Separataor % @B
T Tumbe de i
Import tasks from Excel 12 H 0%
Import wizard 13| jriimbsrs (ordered) 0%
e g Muibers (ordered) - =
Indicate milestones 14 | LR )
Marl tasks that represent 15_ L 0% G
major events in the project as 16 | H ™ 0% G
milestones. The symbol 17 Generate WES code For new task 0% g
indicates a rilestone, ]
18 Werify uniqueness of new WES codes & 1013
Make selected task a
milestane 19 o P ey
| 5 e ]
Done 20 0% @@
B e titarmatian 21| Present Ad Tday| wed 1071310 Wwed 1071310 @
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2.4 Entering a Task

Click on Tasks -> Double Click on task name field to show the task information screen.

icrosoft Project - Project1

@ Eile Edit Wiew Insert Formak  Tools  Projeck  Report  Collsborate  Window  Help Tvpe a guestion for help -5 X
Rl T R e =) Lie &+ = show- | 5 i Eoron o

i[5 Tasks - Resources - | Track - | Report = =

Prn]:ect Initiation
|ﬁ Taszk Mame Duration e | Oct 10,0 |Oct 17,40 Oct 24,'10 Oct 31,'10 Mow 7,'10
|
|
|

SM[TTIF[s[sM[TMW[TIF[S|[SM[TW[T] -

Task Information

General I Predecessors I Resources Advanced l Motes i Custom Fields
| Mame: |P".D‘JEE':'Iﬁlhati0n | Duration: | C| [ Estimated
Percent complete: Priority: >
Dates
Start: | | Einish: v
| [JHide task bar

| [Jroll up Gantt bar to summary

| o]

77 start
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2.5 Making a Milestone

A milestone is a task with zero duration; it is generally used for tracking purposes.

2 Microsoft Pro

fEZf] Flle  Edit  wiew Insert Format  Tools  Project  Report  Collaborate  window  Help Typeia question:For help
0 S S (Cam - S s R @

i[5l | Tasks =~ | Resources ~ | Track = | Report =

D S 4 = Show~ | arial 8 | ® _r W |w=

0 days
Task Mame Duration Start t3,0 Cct 10,10 Cct 17,10 Cct 24,110 Cct 31,10 MNow 7,10 -~
'M|T|W|T|F|SSM|T‘W|T|F|S S|M|T|W|T‘F|S S|M|T|W|T|F|S S|M|T|W|T|F|S S|M|T|W‘T|T_
Project Initistion 0 cdavs Wed 10030 | & 1013 e

2.6 Entering Recurring Tasks

Navigate to Insert->Recurring Task

&2 Microsoft Pro

(hzl] Fle Edit  wiew | Insert | Format Tools  Project Report  Collsborate  Window  Help Type a question for help |~ @ X
E = = =W Mews Task Ins == 8| R | @ .2"‘ % 4 = show=~ | Arial sia x| B r o |w ot
= |kl - | Resod Mews Resource From b
| # Recurring Task... =
|Ta;st ‘.%3 Project... Start 13,0 Oct 10,10 oct 17,10 oct 24,110 oct 31,10 Mow 7,10 ~
. e MITW[T[F[S[S[M[T W[T[F[S[S[M[TW[T[F|S[S[M[TW[T[F[S[S[M[TW[T[F[S[S[M[TW[T[
Frojs wied 1041310 | & 1013 e
| Fage Break B
|
| 4% Drawing
= | Cbject...
— @, Hyperlink...  Cirk

74 start
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:@ File Edit Wiew Insert Format  Tools  Project  Report  Collsborate  Window  Help Type a question for help = & X
= A AR R SR M=y P2 F = cheuo | el ] - EEREe E
i[5 Tasks = Resources = | Track = | Report = =
_ Statement of Wark
Task MName | Duration | [Oct 10,10 [oct 17,110 Oct 24,10 Oct 31,10 Mow 7,10
M[T v FIelsM[TW[TIF[S[EM[TI[TIF[s SM[TMW[TIF[S[SM[T wW[T]

g Task Information

| TaskMame: |St‘at'emé_mt:n'f\n_\ip}"k | Duration: | 2d -

| Recurrence pattern

O raily Recur every
@ weekly
() Monthly [sunday  [IMonday [ITuesday [ |wednesday
O early [ thursday Eriday [ saturday

Range of recurrence

Start: |wed 10/13/10 ~| Oendafter: ocrurrences

= (& End by: |5at 10f16/10 -

week(s) on!

Zalendar For scheduling this task

e calendars

Page 20
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2.7 Creating a Hierarchy of Tasks

Select a task that is to be indented and then click the indent as shown below

@ File Edit View Insert Format  Tools  Project  Report  Collsborate  Window  Help Type a guestion for help -5 X
B = W= WM EEE S R IR A= - W

i [0 |Tasks - Resources =~ | Track =+ | Report = B

P % 4 = show~ | arial -8 =| B I O |w= =

9992
| WHS o  TaskName | Durstion 3,10 Oct 10,10 Oct 17,10 Oct 24,10 Oct 31,10 MNow 7,10 ~
| M [T T [F[S[S[M[TW[T[F[S[S[M[T [W[T[F[S|[S[M[T[W[T[F[S|S[M[T[WT][F|S[S[M][TW[T[F]=
ool Statemsrit of Work 1 dary? =

File Edit Wiew Insert Format Toaols  Project  Report Collaborate  Window  Help Type a guestion for help -5 X
= NN NN B = ga | @ |

: 5 Tasks ~ Resources =~ | Track =~ | Report - B

w 9 9 = Show-~ | Arial -8 | B r U= b

gggl.1

WES €@ |Task Nams | Durstion 13,10 Oct 10,10 oct 17,10 Oct 24,10 Oct 31,10 MNov 7,10 ~
M [T W[T[F[S[S[M[TWI[T[F[S[S[M[T[W[T[F[S[S[M[TW[T[F[S[S[M[T[W[T[F[S[S[M[T[W[T[F|_

gog1 > |Fl Statementof Work | 1 day?

Copy Task

Paste

Paste Special...
Mew Task

Delete Task
Eonk...

Text Styles...
Task Information. ..
Task Motes...
Request Progress Information, .,
Show Subtasks
Hide Subtasks
Outdent

Indent

Hyperlink.. .
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@ File Edit iew Inserk Format  Tools  Project  Report  Collsborate Window  Help

DS QG- -8 =R @

Type a guestion For help -5 X

w = 4 = zhow~ | Aral -8 ~|B I U |w= 1t
P[H Tasks - Resources + | Track - | Report v _

gggl.1 ]
| WES |ﬂ |Task Name |Duraﬁ0n t3,10 Oct 10,10 oct 17,10 Oct 24,10 Oct 31,10 Mo 7,110 ~
| o | MITWITIF[S[SIM[T WIT[F]S[SM[TW[T[F[S|S[M[T WI[T[F[S[S[M[T WI[T[F[S S|M|T|W|T|F\_
aggl | =] Statement of Work 1 day? =

oo 1] Cortext Diagram 1 day? -

e
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2.8 Exercises

Enter the following tasks, in the hierarchy shown here. Do not enter the numbers-just the task

names.
Task No Task Name Duration | Predecessors
Column 0 | Column1 | Column 2 Column 3 | Column 4
1 1 SPM_Project_Team0
2 1.1 Project Initiation
3 1.11 Develop project charter 5 days
4 1.1.2 Develop Statement Of Work 7 days 3
5 1.1.3 Develop preliminary scope development | 3 days 4
6 1.14 Develop preliminary architectural model | 4 days 5
7 1.1.5 Project initiation complete 0 days 3,4,5,6
8 1.2 Project plan
9 1.2.1 Develop scope management plan 1 day 2
10 1.2.2 Develop change management plan 2 days 2
11 1.2.3 Develop initial descriptive budget 10 days 9
12 1.2.4 Develop schedule 2 days 9
13 1.2.5 Develop quality management plan 2 days 2
14 1.2.6 Develop human resource plan 3 days 9
15 1.2.7 Develop risk management plan 2 days 9
16 1.2.8 Project plan complete 0 days 9-15
17 1.3 Project Execution
18 1.3.1 Release 1
19 1.3.11 Analysis phase 18 days 8
20 1.3.1.2 Design phase 15 days 19
21 1.3.1.3 Construction phase 12 days 20
22 1.3.1.4 Validation phase 12 days 21
23 1.3.1.5 Deployment phase 3 days 22
24 1.3.1.6 Closeout 1 day 23
25 1.3.1.7 Release 1 Complete 0 days 24
26 1.3.2 Release 2
27 1.3.21 Analysis phase 9 days 18
28 1.3.2.2 Design phase 7 days 27
29 1.3.2.3 Construction phase 6 days 28
30 1.3.2.4 Validation phase 6 days 29
31 1.3.2.5 Deployment phase 1 day 30
32 1.3.2.6 Closeout 1 day 31
33 1.3.2.7 Release 2 Complete 0 days 32
34 1.3.3 Execution complete 0 days
35 1.4 Project Closeout 1 day 17
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36 | 1.5 ‘ Project Complete

| 0 days

| 35

Steps to do the above task:

2.8.1 Enter the task name

B Microsoft Project
Eile Edit Wiew Insert Format  Tools  PBroject  Report Collaborate  Window  Help

RN - TSR S

Type a guestio

= 2w @ 4% = Show~ | Aral ~8 ~|®B r o &
5] Tasks ~ Resources =~ | Track = | Report = =
SPM_Project_Team0
| @ @ Tasks ] .ﬂ Task Name Durstion Start Flnlsh. .Predece. lM1 lU.T 1|5V|T — I g?hl:l?T 1‘5\[' -
Plan anld schedule vour .E SPM_Project_Team(O 1 day? Bnded 10/ 340 Wed 101340 o]
}’t;?;eifoﬁf'ésli:k‘?n':;"j;kr:"}tgefn” 1 day? Wed 10310 vWed 101310 =
displays tools and instructions 1 day? Wed 101310 Wed 1041310 (=]
for complsting that step. 1 day? | Wied 10/13M0 | Wed 1013410 =
S 1 dey? | Wuid 100 30 Wed 10/310 -
Define gensral working times e SRR A AT i SO @
List the tasks in the project T olay? | Wisd 10113110 | Wed 10/ 3/10 -
Graanize tasks into phases TERi e TR e B -
S 1 dey? | Wiied 10030 Ved 107310 -
i st e 1 dey? | Wuied 10030 VWed 10310 -
infarmation 1 day? | Vied 10/ 3M 0 Wed 104310 -
Add columns of custom 1 day? | Vied 104 3M 0 Ved 10M 3410 -
information 1 day? Wed 104310 wed 1013410 =Y
tsaitk‘iead“”es and constrain 1 day? Wed 10310 wWed 101310 -
Identify risks ta the projsct Ariclaty f oA DA D JINSA 10 3410 -
add documents to the project Jodav? [ Wed 100 341 0] ed 10 310 @
i Bt prsbe it b srmation: o S i e -
the ireb 1 chay? | Wied 100300 Wed 104310 -
1 day? | Vied 10/ 3M 0 Wed 104310 -
After planning your tasks, you 1 day? Wed 101310 vWed 101310 -
can go to the Resources area
Sl e e e s 1 dey? | Wuid 10030 Wed 10310 -
and assign people to tasks. 1 day? wed 1001340 Wed 104340
1 day? | Wied 10 3M 0 Wed 104340 -
1 dey? | Wiid 1001310 VWed 10310 -
1 dey? | Wiied 10030 Ved 107310 -
1 day? | Wied 10/ 3M 0 Ved 104340 =
1 day? | Vied 10 3M 0 Wed 104340 -
1 dey? | Wuied 10030 Ved 10310 -
1 dav? | Wded 1NA M0 Wed 1N 30 =

b L&
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2.8.2 Creating WBS Column

Edit  Wiew Insert Format  Tools  Project  Report  Collsborate  Window  Help Type a guestion for help |+ @ X

: 2 = 22 G o W @ : = ~ | Arial =iy = = 2
= N - R B =dal=HB| @ P o» o+ Show ~ | Aria B I U | B
S 5] | Tasks = Resources ~  Track ~  Report - &
SPM_Froject_Teamni
Task Name Duration Start | Finish |Predeces 10,0 Qot 17,0

@ @ Tasks

Plan and schedule your
project's tasks by clicking an
itern below. Clicking an itern
displays tools and instructions
for comnpleting that step.

3 ~
MIT T [F[S|S[M[T [W[T =

1 dey? Mhied 101310 Wed 10/ 310 |
1 day? | Wed 101310 Wed 1013010
Develop project charter 1 day? | wed 10130 Wed 1013410
Develop Statement Of Work 1 day? | ved 10300 Wed 101310
: 1 |
=
1

Project Intistion

Develop preliminary scope devalopmert day? | wied 1013110 wed 10/ 3410
day? | Wed 10/13/10 | Wed 10/13/10
dlay? | wied 1041 310 | ved 10/ 310
Ved 1001310
ied 1001340
10 Wed 10/ 310
Devell Title: | | f10 wved 10n3M0
10 wed 10/ 310

Define the project
e e e Develop preliminary architectural model
List the tasks in the project
Grganize tasks into phases
Schedule tasks

Link to or attach rmore task
inforrmation

Project inttistion complete

Column Definition

Devel| Field name: |

Add colurmns of custam

. align bitle: | Cenker ~| |
informatian Teval S e +| [0 vea 1onan0
tSaestkr;ieadllnes and constrain Devel [elfls ek |10 | 10 | wed 10M13M0

width: V| Header Text Wrapping :
Teritiby tisles torthe promet DEVE — EID e ETONT SO
P ) M0 Wed 101310

Add documents to the praject rois [ Bestrit | [_ok ] [ cancel | L
Fublish project information to Projeq - 10 Wied 1071310
the web Release 1 day? Wed 101 3M0 Wed 101310

Anslysis phase day? | Wed 101310 ved 104 310
doy? | wed 10310 | ved 104 310
day? | ved 10A 30 wed 10310
walidation phase day? | Wed 1013110 | wied 10/ 310

1
1
after planning your tasks, you 3
1
1
Deploymert phase 1 day? | Wed 10M 310 Wed 104 3M0
1
]
1
1
1
1

can go to the Resources area
to build your project's tearn
and assian peopls to tasks.

Design phase
Construction phase

Clossout day? | Wied 1001310 | ved 10M 310
dey? | wwied 10/ 310 vwed 10/ 310
day? | Wied 10M 310 Wed 104310
day? | Wed 10/13/10  Wed 10/13/10
day? | Wwied 10/ 310 | Wed 10/ 310
AT | Wied TR FA N Wied TOM 30

Release 1 Complete
Relsase 2

Analysis phase
Design phase
Constructinn nhase

v
A

: L_E] File Edit Wew Insert Format Tools Project  Report  Collaborate  Window  Help Type a question for help = & X
s =™ = SR - S R R Lid 9 # = show- | Aid v8 «| B I U|w¥
5 |Tasks - Resources ~+  Track | Report < s
1
@ @ Tasks WS | Task Name Durstion | Stat | Finish 110,10 Oct17,10 A
| I L MITWITIF[S|S[M][T
Plan and schedule your :‘ SPM_Project_Team0 1 day? "Aied 10310 Wed 101340 | (=] |
projectsitosks byanlicking on 2 Project Infiation | 1 day? Wed 104340 | Wed 104340 @
itern helaw. Clicking an itemn
displays tools and instructions 3 Develop project charter 1 day? Wed 104340 Wed 1043410 -
for completing that step. 4| Develop Statemert Of Work | 1 day? | Wed 104340 Wed 1041340 -
Define the project 5 Develop preliminary scope development | 1 day? | Wed 104310 Wed 101340 -
i e E Develop preliminary atchitectural model | 1 day? | Wed 104310 Wed 101340 ]
e e e e T Project intiation complete | 1 day? | Wied 1001310 Wed 10310 =]
S e e e g Project plan | 1 day? Wed 104310 | Wed 10M13410 ]
B el Develop scope management plan A day? | Wied 104310 | Wed 101340 ]
e e A 10 Develop change management plan A day? Wed 104310 Wed 1013410 ]
infarmation 11 Develop initial descriptive budoet 1 day? Wed 104340 Wed 101310 =]
add columns of custom 12 Develop schedule |1 day? ved 10310 Wed 101340 @
infarmation 13 Develop qualty management pian |1 day? Wed 100310 Wed 100340 @
faztk‘:ead“”es and constrain 14 Develop humsn resourcs plan | A ciay? Yed 104340 Wed 101340 @
Enti . shs o the pruiact 15 Develop risk management plan A day? | Wed 104310 | Wed 1013410 ]
At dbcihEnts to the rrtiat 16 Project plan complete | A day? Wed 104 3M0 | Wed 1013410 ]
S e e e e 1?. Project Execution | 1 day‘?.Wedm.ﬂEMD Wed 10M3M0 [
the Wweh 18 Releaze 1 1 day? Wed 104310 Wed 1013410 ]
19 Analysis phase 1 day? Wed 104310 Wed 1013410 [
After planning your tasks, you 20 Design phase | 1 day? Wed 104340 | Wed 104340 @
can go to the Resources area - . .
to build your project's tearn 2 Construction phase 1 day? Wed 104340 Wed 1043410 ]
and assign people to tasks. 220 Walidation phase 1 day? | Wed 104 310 | Wed 10340 -
23 Deployment phase 1 dey? wied 1030 Wied 10M 310 @
24| Closeout | 1 day?| Wed 104340 Wed 104340 @
25 Releaze 1 Complete | A day? Wed 104310 Wed 1013410 ]
26| Release 2 | 1 day? Wed 104340 | Wed 1041310 @
w Analysis phasze 1 day? Wed 104310 | Wed 1013410 ]
28 Design phase | 1 day? Wed 104340 | Wed 104340 @
20 Canstructinn nhase 1 daw? | Wiad 1NAAAN | Yiad 104 RM)H " ‘I-

Ready
iJstart [ @

1_Labol_Man... 1§‘i el

_Lab01_Man... B Microsoft Project - ...
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2.8.3 Creating Hierarchy of tasks

crosoft Project - Exercisel

Eile Edit Miew Insert Formak  Tools  Projeck  Report  Collsborate  Window  Help Tvpe a guestion for help -5 X

s = | @-_l—'\é'lus G IR wl:}:\i | B | @ _:_;‘E-F"iﬂl:ghow' Arial -8 +~| B r Ul i
i[5 |Tasks - Resources ~ | Track - | Repart = =

WES | Task Name Durstion | Start | Finish t10,10 Oct17,'10 A

@ @Tasks

Plan and schedule your
project's tasks by clicking an
tem below. Clicking an itemn

MITW[T[F[S[SM[T [w =

| wied 1013010

day?

“éP‘h‘d‘:P“rme‘cLT“eam‘E‘l

Viied 1003010
I3 oitiation 0

Wied 101340

displays tools and instructions db  Cut Task charter Wed 104310

latlipletinashatsten. 53 Copy Task et O Wiork day? Wed 1041310 Wed 101340

Define the project |54 Paste nary scope developmert day? | Wed 10413410 Wed 10/ 340

Define general working times Piste Sracil rary architectural model day? | Wied 104310 Wied 104340

'aske Special.. . T

List the tasks in the project complste day? | Wied 104 3M0 Wed 1043410
N . Hews Task day? | WWed 1041310 Wed 10M340

Organize tasks into phases

Cobadile tashs Delete Task management plan clay? | Wed 1041310 Wed 101310

Link to or attach mare task A Fort F mansgement plan chay? | Wed 104310 Wed 101310

information ; i escriptive budget day? | WWed 104310 VWed 101310

Text Styles...

le:
Task Information. .. management plan

Add columns of custom
infarmation

day? | Wed 103410 Wisd 1013410
day? Wed 10M 340 Wisd 1013410
Task Motes... resource plan day? Wed 101310 Wed 101310

1

1

1

1

1

1

1

1

1

1

1

1

1

Set deadlines and constrain 1

nagement plan |1 day? Wed 10A3A0 Wied 10310

1
1
1
1
1
1
1
1
1
1
1
1
1
1

tasks

Identify risks to the project Request Progress Information. ..
add docurnents to the project noiste day? | Wed 101310 Wed 104340

day? | Wed 10 310 Wied 10M 310
cay? | WWed 104310 VWed 1013410
day? Wed 10M 3410 Wisd 1013410
day? | Wed 10M 310 Wed 10M 310
day? | Wied 10M 340 Wisd 101310
day? | WWed 104310 YWed 101340
Ay OWiE 10A 300 W 100 31‘1)“ |

23 Deployment phase
24 Closeout
25 Release 1 Complete
26 Release 2

4 Show Subtasks
5 day? | Wed 101310 Wied 1013510
Publish project information to " i1 it b o
the Wweh = Hide Subtasks day? | Wed 10413410 Wed 10/340
“  Qutdent day? | Wed 104310 VWed 1011310
afternlenning velisa st o = day? Wed 104310 Ved 10/ 310
can go to the Resources area = Indent
ta build your project's team ase cay? | Wed 103010 Wied 1013510
and assign people to tasks. 22, Hyperlink... = day? | WWed 1013410 Wed 101340
-
1

27 Analysis phase
25 Design phase

] Coonstrurtinn nhase

3

Ready
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B Microsoft Project - Exercisel E]

File Edit View Insert Format  Tools  Project  Report  Collsborate Window  Help Type a guestion for help = @ X

=s @

R T Y SR

Ll
{5 Tasks +  Resources v | Track + | Report =

| B | @

i@ P 4+ = Show-= | Arial -8 | B I U|v 2

Al

@ @ Tasks b4 [i] WWHS Taszk Mame Duration Start Finizh
Plan and schedule your 1 SPM_Project_Team0 | 1 day? Wed 101310 Wed 1013110 =
project's tasks by clicking an o
e e 2 Project Initiation 1 day? | Wed 104310 Wed 1041310 -
displays tools and instructions ]
for cornpleting that step.
P a =} =]
Define the project 7 -
Define general working times E o
List the tasks in the project B cukTask =]
= Vi
Organize tasks into phases Fo W 1 day? Wed 10310 Wied 1013410 (]
Ba o =
S hbiuie tals e management plan 1 day? Wed 104310 Wed 101310 (]
i [ i
i i e ._]5 Paste nge management plan 1 day? Wed 101310 Wed 101310 (]
information Paste Special. . | clescriptive budoet 1 day? Wed 104310 Wed 104310
add columns of custom T edule 1 day? Wed 104340 Wed 104340 ]
H 1 e [ asl
infarmation o ity management plan 1 day? Wed 10/ 310 Wed 10310 &
;Saztk‘:ead"”es and constrain Delete Task an resource plan 1 dary? | ed 104340 Wied 104 300 @
g
Fdentt i s ketto the proest A Fort... management plan 1 day? Wed 101310 Wed 101310 -
: i = liete A day? Wed 10 3M0 | Wed 1013410
Add documents to the project ; Tewk Styles... omiiete: Nt i i =]
s - : : ian 1 day? Wed 10/ 310 Wed 10713410
Publish project infarmation to Task Infarmation. .. o > @
the Weh = 1 day? Wed 1013410 Wed 101340 -
T = = 1 day? Wed 104310 | Wed 101310 -
B s s’ W% reauest progress rformation. . P 1 day?|Wed 101 3A0| Wed 1013401
ta build your project's tearn & Show Sublasks phase 1 day? | Wed 104310 Wed 10113410
and assign people to tasks. ASE 1 day? | Wed 104310 | Wed 10713410 -
= JERERERS hase 1 day? | Wed 104310 Wed 1013510 @
@ Dukdent 1 day? Wed 104310 | Wed 101310 (]
% Indent mplete 1 day? | Wed 104310 Wed 104310 @
25. G = A day? | Wed 10 3M0 | Wed 1013410 (]
Hypetlink,..
1 day? Wed 104310 | Wed 10713410 -
28 27 Design phase 1 day? Wed 101310 Wied 1013410 (=] L7
29 7R Cnnstruction nhase 1 rdav? | Wded ANA RN Wiad 1NM 340 = = |
< 2| || (| >

File Edit ‘iew Inserk Format  Tools  Project  Report  Collsborate Window  Help Type a question for help = @ X

DEH &R RR9-C. 8 =58

@ @ 4 = Show~= | Arial ~8 ~ B I U | =

- | Resources ~  Track - Repart =

@ @D Tasks a WWBS Task Mame Duration Start Finish
Plan and schedule your 1 SPM_Project_Teamo | 1day? Wed 1013110 Wed 10113110
ﬁ;";‘_‘{egtelsnfs"(‘:Ti:k"in':g'":a'f_:r}tgefn” 2 Project Inttistion 1 chay? | Wied 104310 Wed 101340
displays tools and instructions 3 1
for completing that step. 4

. . 5
Define the project
Define general working times =
< : 7
List the tasks in the project - = .

: y Cut Task day? | Wied 10340 Wisd 1013410

Grganize tasks into phases
ehbiile tasle 53 Copy Task management plan day? Wed 104340 Wed 101310
iRt At Se ey astasle Lji Paste & management plan day? Wed 101310 Wed 101310

escriptive budget day? Wed 104340 Wed 101310

=]

]

o

=]

=]

o]

=]

5]

[~ ]

chay? | Wed 1041310 Wed 1041340 =]
day? | Wed 104310 Wed 101310 =]
day? | Wed 1041310 Wed 10M3410 [=]
chay? | Wied 1041310 Wed 104340 -
=]

=]

=]

=]

=]

=]

=]

5]

=]

]

o

information :
Paste Special...

Add columns of custom le:

infarmation Mew Task management plan

Set deadlines and constrain

resource plan
Takia Delete Task P

nagement plan
mplete

Identify risks to the project A Font...

=
add docurnents to the project Text Styles... day? | Wed 1061310 Wed 10M310
il cay? | Wed 10A3M0 Wed 101310

1

1

1

1

1

1

1

1

1

Fublish project information to !

Task Infarmation. .. 1 day? | Wed 104310 Wed 10713410

1
1
1
1
1
1
1
1
1
1
1

the Wweb

day? | Wied 101340 Wisd 1013410
chay? | WWed 104310 Wed 101310
day? | Wied 101340 Wisd 1013410
day? | WWed 104310 VWed 101310
day? | Wed 1013410 Wisd 1013410
clay? | Wed 104310 Wed 101310
day? | Wed 1013410 Wisd 1013410
cay? | Wed 104310 VWed 101310
chay? | WWed 104310 Wed 101310
clay? | Wed 104310 Wed 101310
Ay WiE 10 300 W 100 3r1>n

After planning your tasks, you
can go to the Resources area
to build your project's tearn
and assign people to tasks,

ation. ..

t Progress Inforr

+» Req
4  Show Subtasks
= Hide Subtasks SE
@ outdent
lete:
= Indent
=, Hyperlink,..

28 22 Design phasze
29 23 Cnnstructinn nhase

<l %
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File Edit Wew Insett Format  Tools  Project  Report  Collsborate Window  Help Type a question for help = & X
N H RR @908 = s h @ Cie % & = show- | Arial 8 =| B I W |vYa :
5] Tasks ~ Resources « | Track « | Report k
@ @ Tasks %3 5] WBS | Task Hame Duration Start Finish 110,10 Oct17,10 A

— ! { - . MIT WITF|S[S[M|T W
Plan anld SChldeIethDchn o | Wed 101310 Wed 101310 = T
ﬁ;?'\!velilsnt;aécslickﬁng an itgem Wat 10410 Wedana she e
displays tools and instructions [+
for completing that step. @
Define the project @
Define general working times @
List the tasks in the project @
GRS S T B A : 2 Project plan 1 day? Wed 101310 Wed 101310 [
L ] 3 Develop scope management plan 1 day? | Wed 104310 Wed 10113410 -
i e 1o | 4 Develop change management plan 1 day? | Wed 10310 Wed 101310 -
information 11 a Develop inftial descriptive budget 1 day? Wed 101310 Wied 1013410 (=]
Add columns of custom 12| | 6 Develop scheduls 1 cay? | Vied 10310 | Wed 1013010 @
information M 13 7 Develop gquality management plan 1 day?  Wed 104310 Wed 10/340 ]
tsaztk‘:ead"”es and constrain 14 _ 8 Develop human résource plan 1 day? | Wed 104310 Wed 1013510
Idenii s ks tto e proest 15 | | =] Develop risk management plan 1 day? Wed 101310 Wisd 101310 (=]
T e e ) 15 | | 10 Project plan complete 1 day? Wed 101310 Wied 1013410 [
e et T e e 17 | 11 Project Execution A dlay? Wed 101310 Wisd 101310 [~
the Wweb 18 12| Releass 1 1 day? | Wed 10310 Wed 101310 -
13 | 13 Analysis phase 1 day? | Wed 1041310 | Wed 10/ 3410
After planning your tasks, you 20 | | 14, Design phase 1 chay? | Wied 104310 VWed 101370 @
can go to the Resources area + -
to build your project's tearn 21 15 Construction phase A clay? Wied 101310 Wied 101310 [~
and assign people to tasks. 7| 16| validation phase 1 day? | Wed 104310 | Wed 1013410
23 | 17 Deployment phase 1 day? Wed 101310 Wed 101310 (=]
24 | | 18 Closeout 1 clay? | Vied 10/ 310 | Wed 1013410 @
25 | | 19)  Releass 1 Complete 1 chay? | Wied 104310 VWed 101370 @
26 | 20 Releasze 2 A day? Wed 101310 Wied 101310 -
27 | il Analysis phase 1 day? | Wed 1041310 | Wed 10/ 3410 [+
28 | | 22| Design phase 1 chay? | Wied 104310 VWed 101370 @ o
<29 | 73 Canstroction nhase 1 rlav? | Wied 13N Wied 104 ?m)n e a= - =

Exercisel

l'l_F] File Edit Wiew Inserkt Format Tools  Project  Report  Collaborate  Window  Help Type & question for help = & X
R W R NREER R R IR - | a @ Tiw % & = show- | Aral 58 BB r T %
5] | Tasks - Resources ~ | Track -~ Report - =
1 day?
o WBS  |Task Name Duration Start Finish Oct 10,10 Oct 17,110 Oct 24,10 A~
. | i _ [FIs|sM[T WITIF[S[SM[T T [F]S|S[M[T WTIF[{=
gl SPM_Project_Team0 1 day? Wed 101310 Wed 101310 == 1
2 Project Initiation 1 day? Wed 101310 Wed 101310 L=
3 111 Develop project charter 1 day? Wed 10M3M10 Wed 101310 [~
4 112 Develop Statement Of Work 1 day? | Wed 101310 Wed 101310 [~
5 | | 113 Develop preliminary scope development 1 day? Wed 101310 Wed 101310 [
5 | 114 Develop preliminary architectural model 1 day? | Wed 101310 Wed 101310 [
i+ % Project intistion complete 1 day? | Wed 101310 Wed 101310 [~
g 1.2 Project plan 1 day? Wed 101310 Wed 1011310 L=
3 1.24 Develop scope management plan 1 day? Wed 101310 Wed 101310 [~
10 122 Develop change management plan 1 day? | Wed 101310 Wed 101310 sl
11 123 Develop intial descriptive budget 1 day? Wed 101310 Wed 101310 [~
12 124 Develop schedule 1 day? | Wed 101310 Wed 101310 [~
13 125 Develop quality management plan 1 day? Wed 101310 Wed 101310 [
14 126 Develop human resource plan 1 day? | Wed 101310 Wed 101310 [
15 2T Develop risk mansgement plan 1 day? | Wed 101310 Wed 101310 -
16 128 Project plan complete 1 day? Wed 101310 Wed 101310 [
A7 | 1.3 Project Execution 1day? Wed 1011310 Wed 101310 =
1B | 1.31 = Release 1 1 day? Wed 101310 Wed 101310 ==
19 | 1314 Analysis phase 1 day? Wed 101310 Wed 10/13M0 [~
20 | | 1312 Design phase 1 day? Wed 101310 Wed 101310 -
21 | | LS Construction phase 1 day? Wed 101310 Wed 101310 [~
o 1314 Yalidation phaze 1 day? | Wed 101310 Ved 1071310 [
23 | 1:888 Deployment phase 1 day? Wed 101310 Wed 101310 -
24 | | 1316 Closeout 1 day? | Wed 101310 VWed 1071310 [~
25 | | 1317 Release 1 Complete 1 day? Wed 101310 Wed 101310 sl
26 | = Release 2 1 day? Wed 101310 Wed 1011310 L= =)
| 13241 Analysis phase 1 day? Wed 101310 Wed 101310 [~
25 | | 1322 Design phase 1 day? | Wed 101310 Wed 101310 - v
<29 | 1323 Crnstertinn vhase 1 dmw? | e TNM AN Wied 100 3r1>n | - . — |
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2.8.4 Entering the duration of the task

File Edit Wew Insert Format Tools FProject  Report  Collsborate  Window Help Type a question for help = & X

DEH SR 2@l 9--- 8 =588 Ziw P 4 — show- | Al -8 ~|B 7 U|v= :
: 3  Tasks ~ Resources + | Track + | Report  ~ -
15 days
WS Task Mame Duration Start Finish Predece ©ct 10,110 oct 17,10 ©ct 24,110 ~
- - B B . - i FIS|s[m[T W[T[F [S[S[M[T [T [F[S|S[M][T [W][T [F [?

T 1 PM_Project_Teami wed 1041310 Fri 11/5/10 = b

2 | 11 Project Initiation e Wed 10/13/10 | Thu 10:21/10 e

Z | 1124 Dewvelop project charter § \nied 1041310 Tue 101940 ————]

4 112 Develop Statement Of Work wed 1041310 Thu 10/21/10 R

s | 113 Develop preliminary scope development \Wed 104310 Fri10A5M0 P

5 1.4 Develop preliminary architsctural mode! Wied 104310 hon 104510 e

7 115 Project initiation complete Wied 10/ 310 Wed 104310 & 1043

5 1.2 =l Project plan Wed 10/13/10 | Tue 10:26/10 -

4

8 | 1241 Develop scope management plan Ved 1001310 Wed 1041310 -
10 | 122 Develop change management plan Wed 10A3M0 Thu 10/14410 -_—
| 123 Develop inflisl descriptive budaet - Y vied 10/3110 Tue 10/26/0 ]

12 124 Develop scheduls W iac 104310 Thu10M 440 -_—

13 125 Develop qualty management plan . Wed 10430 Thu 1041450 —_—

14 126 Drevelop human resource plan Y vied 104310 Fri 10A510 ——

15 127 Drevelop risk management plan Wed 101310 Thu 10714010 —

16 | 128 Project plan complete AR sod 100310 Wed 101340 & 1013

B 1.3 Project Execution Tl Wed 1041310 Fri 11/510 L

18 | 134 =l Release 1 LI Ty wed 1011310 Fri11/5/10 o

13 1314 Analysis phase 1 Wed 10A3M0 Fri11/5010 1
1312 Design phase 1 Wed 104310 Tue 11/2A0 e —
1313 Construction phase 1 Wed 104310 Thu 10/2810 TR
1314 validation phase 1 Wed 101310 Thu 1028010 P T ——TTT—
1315 Deployment phass WWed 104310 Fri 1045M0 [re—
1316 Closeout e 104310 | Wed 104 310 @

25 1317 Release 1 Complete Wed 104310 Wed 104 310 & 1013

2 | 132 £ Release 2 Wed 10/13/10 Mon 10:25/10 > >

27 1324 Analysis phase Ved 10310 Mon 1025010 ————————————————————

25 1322 Design phase Y vied 104310 Thu 1021710 e — 5

29 1323 Constructinn nhase e 1 0A 3A 00 Weed 1072040 — ] = |

2.8.5 Gantt Diagram

Select View -> Gantt Diagram

File  Edit Eroject Report  Collaborats  Window  Help Type a guestion for help = & X
== Calendar = 5@ | B Tl % 4 = Show- | arial g gy e Y 32
? v | Gantt Chart N
Metwork Diagram 2
rr=r Task Usage e Oct 10,10 Tct 17,10 Tct 24,10 Tt 31,10 Mow 7,10 ~
Tracking Gantt SS[MITWI[T[FIS|S[M[TWI[TIF[S(S[MITWITIF[S[S[M[T[WI[T[F[S[S [M[TW[T
| 18 days \ | = = n
2 Resource Graph 7 days v | e -
3 1 Resource Sheet 5 days —
4 AN ressireeusans ork [ Tams| P
5 1 e development Sdays || Pr—
3 1 BiEsyiees, litectural model 4 days | —
- : Table: Entry » TR & 1013
8 Toolbars » 10 days |\ | - =
g 12y Turn OFF Project Guide et plan 1day || [—]
L 1 P ment plan 2days || -
1 1 buctget 10 days |- P
=l 42 Show cChangs Highlighting ™ dya T -
13 1 Header and Footer... ent plan | Zdays |t —
14 1 e 2 plan 3 deys —
15 1 DEEICE TS TENEgerET plan 2days | -_—
16 128 Praoject plan complete Odays " | & 1013
17 1.3 Project Execution 18 days |\ = o
18 | 134 =l Release 1 | 18 days v | & 5
19 | 1341 Analysis phase 18 days " | "
z0 1312 Design phase [ 15 dmys| | e EETETE}Y}YEYEY
= 1313 Construction phase | 1zdays P e R S
22 1314 “alidation phese 12 days o
23 1315 Deployment phass Sdays || —
1316 Clossout 1day -
1317 Relsase 1 Complete Odays | & 1013
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3 ADDING MORE DETAILS TO THE WBS

3.1 Assigning Predecessors to Tasks

Double-click the task that needs the predecessors. Select the Predecessors & enter the ID for the
task on which selected task is dependent & then select the type of dependency needed.
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3.2 Gantt Diagram with relationships
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3.4 Setting Constraints on a Task
Double-Click the task, select the Advanced tab on the task information screen, click the drop-down
arrow next to Constraint Type & select a constraint type.
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4 ADDING RESOURCES TO THE WBS
4.1 Displaying the Resource Sheet

Navigate to View->Resource Sheet.
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Or click on Project Guide Toolbar->Resources
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20 1312 Design phase | Sdays Mon 122000 2
=] 1313 Construction phase | 12days|  Mon 14041 1
22 1314 waldation phase 12days | Wed 1026011 1
3 1315 Deployment phase | Gdavs| FriZA1A1
24 1316 Closeout | Admy Wied 2641
25 1317 Release 1 Complete Odays  Wed 2/16M1
2% | 132 =l Release 2 | 30days Thu2A7A1 4
i 1520 Analysis phase Sdays|  Thu2HTHT 4
25 1322 Design phase Toays|  Wed 32011 3
29 | 1323 Construrtinn ohase Firdavs FriZM1M1 ;J Z = _..‘J
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4.2 ADDING RESOURCE ATTRIBUTES

Resource Name is the title of resource to be used

rosoft Project - Exercisel

@ Eile Edit Wiew Insert Format Tools Project  Report  Collaborate  Window  Help Type a guestion for help -5 X
A == W= - S e RO R W= A - Zie o & = show~ | Arial TR e &
([ |[Tasks| - | Resources - | Track - | Report -
BS Project Manager
Resource hame Type  |Material Initials |Group | Max. Units | Std. Rate Ot Rate Costillse |Accrue &t |Base Calendar |Code -~
| | [Eaics) | | | | | | | | |
BS Project Manager  [Work B 100% F0.00Mr F0.00Mhr $0.00 Prorated | Standard
I:! | ] | I
S Developer Wiork s 300% $0.00Mr $0.00MHr $0.00 Prorated Standard
~
—|
¥

] =] BT |E

Max Units represents the maximum capacity for which resource is available to accomplish the task.

B Microsoft Pro

@ Eile Edit Wiew Insert Format Tools Project  Report  Collaborate  Window  Help Type a guestion for help -5 X
=™ | (& | Ea @]9~ - 5o G@ % P B 4 = Show- |[Avial 2 | R 1S T ¢ i
: [ | Tasks = | Resources = | Track ~ | Report = B
| 300%
(i} Resource Name | Tvpe Material (Inttials Max . Units Stel. Rats vt Rate Costllse  Accrue At Base Calsndar  Code T
| | |Label | | | | | | | | |
| BS Project Manager  Work B 100% $0.00MHr $0.00Mhr $0.00 Prorated Standard
SWW Developer Whiork s I 300% :I $0.00MHr $0.00Mhr $0.00 Prorated Standard
]
S— i
b— |
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4.3 Entering Multiple Pay Rates

Double-clicking the resource and displaying the Resource Information Screen->Costs tab. Changing
the rates for a given date range or specifying another pay rate for another calendar

E‘ Microsoft Project - Exercisel

‘hzf] Ele  Edit  view Insert Format  Tools  Project  Report  Collaborate  Window  Help Type a question For help = & X

E = = W= - RE -, BN R - R = B s = = Show =~ | Arial 8 x| B r W |5
[0 Tesks - | Resources - | Track < | Report - o
o Resource Mlame | Type

hsterial Initials | Group e, Units
Label |

Std, Rate | Owt. Rate | Costllse | Accrue At |Base Calendar | Code

BS Project Manager Standard

General l Costs i MNotes I Custom Fields i

Resource name: | S Developer | Initials:
- et | [ —
[(windows Account... | | | code: I |
EBooking type: | Committed ~| Ivpe:

Mat

| | [ Generic []eudget

Inan

Change working Time ...

i

|2l wed 10/13/10
| | Avvailable From Available To Uniks
| |wed 10/13710 BERMA 300%s

— 4 October, 2010 [ 2

S M T W T F
26 27 330 1L
8

~

(oo ] [ox__J [ canemt ]

@ File Edit View Insert Format  Tools Project  Report  Collsborate  Window  Help Type a guestion for help = & X
= W= R RN R IR - S - Zie % & = show~ |l Zie. EliE T Bi
E Tasks - Resources =~  Track -  Report - =
o Resource Name iType Material Intials |Group |Max.Un|ts Stol, Rate Ovt. Rate Costilse iAccrueAt |Base Calendar  |Code A
Lakel | |

| Standard

BS Project Manager

Resource Information

General l Costs i Notes I Custom Fields i

Resource name: | 5% Developer | Initials:
— [ T —
—— [Mndows Account. .. ] | | Code: I:l
Booking type: |Cnmmitted vl Type:

' | | [] Generic [ Budget

Default Assi

Resource Availability Inactive
= N e
Available From | Available To Linits clEpaciterk i
e 10f13(2010 [ Thu 10/14/10 Tl 00

——— 4  October, 2010 3

— 26 27 3 4 2
I 3 4567839
1w[13]12 13 ~

17 18 19 20 21 22 23
2357880 (e I oc I oo

day
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= 1 Projec isel
:@ Eile  Edit Toals

Project  Report  Collsborate Window  Help Type a question for help = @ X
N EH &3 B 9t | = a5 B & %+~ show- | Arial -8 | B I U|v= B
E Tasks - | Resources - | Track - | Report - 5
Resource Name [Type  Material  Intials |Group Max_ Units | Std. Rate | Owt. Rate | Costllse | Accrue At |Base Calendar | Code |
| |Label | | | | | |
BIS Project Managsr | ¥y - - e — nn | |
‘T " w,_Resource Information
General Costs 1 Notes l Custom Fields j

Resource Name: |5W Dieveloper |

Cost rate tables

Far rates, enter a value or a percentage increase or decrease from the previous rate, For
instance, if a resource's Per Use Cost is reduced by 20%, type -20%:.,

& (Default) B C | D [ E
[ $10.00/h S|
|Effertive Date | Standard Rate Overtime Rate Per Use Cast
- $10.00/h $15.00/h $0.00

&

Cost gocrual: | Prorated
[ Details... ][ oK ][ Cancel ]

4.4 Entering Equipment and Material Resources

Double-Click an open row on resource sheet. Click a drop-down box in the Type Field and select
Material

EZ] mile Edit  wiew Insert Format  Tools Project  Report  collsborate  window  Help Type a question for help |~ & 2

N = W - S B R SR W ==RC- “ & &=~ Show~ | Arial -8 | B r U |s B
i[5 |tasks| ~ | Resources ~ | Track ~ | Report -

|.=_. |ResnurceName [Type  |Material intials [Group |Ma>< Unit= | Std. Rete | Gt Rate | Costilss | Mcorus &1 |Base Calendar | Code -~
| Lakel |

BS Project Manager
S Developer

Standard

Resource Information Standard

Eth le General | Costs | Notes |  customFields |
Resource name: | Ethernet Cable | Initials:
[ | Group:
Windows e I | G
. T .
Bonbicicpes | Sommitted ~| Iype: [Material  [&d]
material label:
Material
- | Cosk
-~
| ~

‘s start
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fhzf] Eile  Edit  Wiew Insert Format  Iools  Project  Report  Collaborate  Window  Help Type & question for help [+ & X
P0G B s ga B @ Zis 2 + — show- |[aral - ~|B r U | g

{3 | Tasks ~ | Resources = | Track =~ | Report = o

e =
[ Kiw | wiork
=) Resource Name iTypE Material lInitials | Group Manc. Units | Std. Rate Owt. Rate Costllse |fLccrue A1 | Base Calendsr | Code -~
| Label | | =
1 BS Project Manager | work B 100% $0.00/hr $0.00hr $0.00 Prorsted | Standerd
2 Sw Developer = 100% $0.00hr $0.00hr $0.00 Prorsted | Standard
3 Ethernct Cable E 100% $0.00Hr 000 $0.00 Prorated | Standard

4.5 Editing the Resource Calendar

You can add specific working times and days by double-clicking the resource, selecting the Working
Time Tab in the new window that appears & specifying the new work times.

:@ File Edit Wiew Insert Format Tools  Project  Report  Collsborate  Window  Help Type a question for help |+ & X
= W S NG - M == :

i [[F |Tasks - Resources ~ | TracH

. o= ~ | Arial + & - =
o @ % Show rial B E 1T | s &

Resource calendar for 'Sw Developer':

(1] Resource MName ase Calendar ECode |
| Base calendar: | Standard v T il
1 BS Project Manager andarc

Legend: Click on & day to see its working times:

Oictober 2010 A || October 13, 2010 is norwarking.
s m[T[w][Tth|[F T

Ethernet Cable

i Working

=]
Monworking ‘

e i - R I I

botis IFE EENEP T4 (15 |18 |

©n this calendar: : Based on:
A7 |18 (19 (20 |21 |22 |23

Exception day Exception 'Sravanthi' on calendar 'S

24 (25 |26 |27 |25 |29 |30 Developer',
Nondefault work
— | week 31 Tl
— i Exceptions Wark Weeks |
— : _ |Mame | Start |F Al Details...
1 | Sravanthi fwed 10/13/10 &

4  October, 2010 B [ Delste 1

SM T W TES

272V 930 1 2
3 456 789
12:1314 15 16
17 18 19 202122 23
24 25 26 27 28 29 30
3E L 2 3 5 6

oday

[

[ =0 ] [ Cancel ]
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] File  Edit iew Insert Format  Tools  Project  Report  Collsborate  Window Help Type a question for help (= @ %
NSH @R B9 8 P2+ = on- | prd e - B LU v i

i [3 |irasks| - Resources. - 'Qhange Wo e |5

Resource calendar for 'SW Developer': T
a Resource Name P aze Calendar | Code

Base calendar: | Standard
il BS Project Manager

Legend: Click on a day to see its working times:

Workin October 2010 | October 13, 2010 is nomworking.
2 s mlT[wlth]F T

=
112

andard

Ethernet Cable

Monwaorking

Edited working - RGN

hours ETE EEN P 14 |15 |16 |

On this calendar: : Based on:
— T A7 |18 |19 (20 [ |22 |23

Exception day

Exception 'Sravanthi' on calendar 'S

24 |25 |26 |27 |28 |29 |30 Developer',
Nondefault work -
= week 3 |
— T Exceptions work \Weeks I
e | Mame Start | Finish Details. ..
1 | Sravanthi 10f13(2010 [Tue 11/30/10 &

i
- ;

S MT WTF §

— | 311+ 2 3 4 5 6
7 8 910111213
14 15 16 17 18 19 20
| 2122 24 25 26 27

= | L oK ] [ Cancel

‘izl] File Edit  view Insert Format  Tools  Project  Report  Collsborate  Wwindow  Help Type a question for help

e = M e S = N S Rl S

Show + | Arial 8 ~|B r U |v=

P[5 Tasks ~  Resources ~ | Track

Resource calendar for 'SW Developer':

5] Resource Name hse Calendar | Code

Base colfifS

for ‘Sravanth

L BS Project Manager andard

Legend:] set working times For these exceptians

Ethernet Cable O Nonworking

(&) working times:

Fram To
800 Ar 12,00 Pra
1:00 Pr 4:00 Pl

[N

Recurrence pattern

@ Daily Every
| T O weekhy
T 1 O monthly

= O sarly |

Range of recurrence Lie
Skart: |wed 10/13/10 ~| End after: occurrences

(&) End by: | Tue 11430010 ~

days

. | [ ox ) [ e ]
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B Microsoft Project - Exercisel

(] e Edit  Miew Insett Format  Tools Praject  Report  Collsborate  Window  Help Type a guestion for help & X
O = S N B A N W= ) i 9 4 = Show= | Al -8 - B I U|w B
E Tasks ~ Resources - | Track - | Report - =
a Resource Name |Type haterial Initials Group |Max.Units Stl. Rate | Owt. Rate | Costillse iAccrueAt |Basze Calendar | Code
Label |

B Project Manager

Resource Information

3 Ethernet Cable i General |

Casts i

Notes I

Resource name: | S Developer

Initials:

Email; |

| Eroup!

[wlndnws Account. .. ] |

| cCode:

Booking type: | Cormmitted

Type:

4 al label:

Default Assial

Resource Availability

%] wed 10/13/10

| wailable From | Available To

Units

wed 1001310 BEfMa

100%:

4  October, 2010 p

S M-ESW T OUELSS

26 27 0k 2

— | 3 4567879

w123 141516
17 18 19 20 21 22 23
24 25 26 27 2829 30
3 1 23 456

S|

Custam Fields i

| Standard

[ Generic [ Budget

Inactive

Change Warking Time ...

[ Details... J L

Ok

][

Cancel J

& Microsoft Project - Exercisel

(iZf] File Edt  Wiew Insert Format  Tools  Projoct  Report  Collsborate  Window  Help Type a question for help = & X
A = B RS R - = % | @ Pe 9+~ show~ | Arial >0 =| B r U |v= B
: 5  Tasks - Resources - | Track - | Report = &
[5) Resource Name |Type Naterial Inttials Group | Max Units | Std. Rate Ot Rate | Costilse |Sccrue At |Base Calendar | Code
Label |

BS Project Manager

3 Ethernet Cahle

General | Costs | Notes |
Resource name: | 5w Developer | nitials:
Email: [ | Group:
[#indows Account... | | | code:
Booking type: | cormmitted ~| Iype:
Default Assial |
Resource Availability

®le] Thu 10f14/10
Availsble From | Available To Units
100%:

10/13/2010 [ Thu 10/14/10 %]
4

ber, 2010

S MTWTF

12 3 4568

7 8 9210111213

14 15 16 17 18 19 20
21 22 23 24 25 26 27
30 2 3 4

28 29

|

Cuskam Fields i

Standard

[ Generic [ eudget

Inactive

Change Working Time ...

[ oetais.. | [

oK Cancel |

Today

———
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4.6 Dealing With Over Allocated Resources

Navigate to View ->Resource Usage to determine whether a resource is over allocated. Now,
navigate to task->Double-click on task name -> Resources tab to assign resources to the task.

Tools  Project  Report  Collsborate  Window  Help Tvpe a guestion for help

NS H &2 B2AR9-¢. 8 =616 @ P % 4 = Show- | Arial v8 F|B I U |
= Resources ~  Track = Repart = El
Develop project charter
WHS Task Mame | Durstion | Early Stat | : .10 Oct17, 10 Cct 24,10 CQct 31,10 Moy 7,0 Plon o
B | | T[S [SMITMWIT[FIS[SMITATIF[S|SM[TWIT[F[S[SMIT T [FIS[S] =
1 = SPM_Project_Team0 120 days = Wed 1011340 )/ @
141 =l Project Initiation 17 days | Wed 101310 )/ ‘ &
Task Information
Genersl | Predecessars Resources advanced | Motes | custom Fields
L1y Develd  name; |Develop project charter | puration: |5d 2| estimated
115 Projecs Resources: @ (1174
1.2 =l Project }ﬂ_{] ES Project Manager i - il 7:'
124 | Devel | Resource Hame Assignment Cwner Units Cost E
122 Devel | BS Project Manager 100% 40,00
125 Devel
124 Devel
| 125 Devel S Developer
128 Devel
| 127 Devel
128 Projec
| 1.3 = Project H
134 Fl Relea
1311 I 156
1312 D
1314 R
131 .5. Deployment phaze Sdays Wyied 20911
1318 Closeout | tday,  Monziamtn
1317 Relesse 1 Complete | Odays|  Mon 20411 2
13.2 =l Release 2 | 30days  Tue 21511 Y
1321 Analysis phase 9 days Tue 211511
1322 Design phasze 7 days Mon 252811 2 i3
1373 Canstrictinn nhase R davs Widrrd FAMT ==
8 o 3y

Page 45



CS591 Course: Microsoft Project 2007 Lab Manual

Edit  “iew Inserk  Format | Toals hEro]ect Report  Collsborate  Window  Help Type a question for help - f X
PO EF (] Ga @ 9 - |V speling.. F? “ie % & = Showe | Al .8 +| B I U | v "
Auta, £ Opi :
5 A Mew Resource F AttoCortecbpHonsi =
T
- o 237 S0% T34 100 Document Managerment
: SHE SIS 2
e Links Between Projects. ..
i = Impart Outlook Tasks...
- | Resources - Track -
Change Working Time. ..
Develop projec! -
@ © rasks B Assign Resources... Al+F10 7, War B, 11 War 13, 11 War 20, 11 War 27, 11 e
1 Buld Team from Enterprise...  CteT (T[T IF]S [SMITITIF]s [SMITIWTIF]s [SMITIWTIF [S[SMITIWITIF[S]i=
Plan and schedule vour el T
project's tasks by clicking an 26  Substitute Resources...
tem below, Clicking an item : b
displays tools and instructions Local Project Cache L2
for completing that step. Resource Sharing s
Define the project Level Resources. .. & 2128
Befine et ol e ks i tking - Analyst 2 Project Manager 1 [0%],Project Manager 2 [0%],Cellphone1[1]
List the tasks in the project Macro >
Organize tasks into phases
Schedule tasks Crganizer.; 1 ,Project Manager 2 [150%]
Link to or attach more task Glitomize, ¥
infarmation il
Add columns of custom
information Enterprise Cptions » Anak 3
?aestkgeadllnes and constrain 14 126 Develop human ¢
et i A T e 15 127 Develop risk man roject Manager 2
: 15 128| Project pl 319
Add documents to the project = = rolpeLpan comy | hd
i - 3 i 1.3 =l Project i
Publish project infarmation to et | ! _ro]e e
the Weh 18 1.3.1 =l Release 1
19 8333 Analysis pha:
After planning your tasks, you o0 1312 Design phase
can go to the Resources area - -
to build your project's team 1 131.3] Conztruction
and assign people to tasks. 22 1314 alidstion phe
23 3305 Deployment p
24 1316 Clozeout P
4247 Felaana 1 Cn — |

| &
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[2]

File Edit iew Insett Format Tools  Project  Report  Collsborate  Window  Help Type a guestion for help = @ X
NEH &R BE9-0- 0 =858 @ Liv % & = show-| il -8 -|B I U|v= %
i @B | 596 | MewResourceFrom> | B W L L1 f el | T Ty E
: i i =S| 0% 254 S04 754 100
N T SEESES 2%

PR = e -
DEEEEME,
(5 Tasks ~ | Resources v | Track - | Report v _
=
Develop project charter
@ ®Tasks WHBS | Task Name 027,11 War 6, 11 Mar 13,11 War 20,11 Mar 27,11 i
| MITWITIFIS[SMITIWITIFIS[SM[TWIT[F[s[SM[TW[TIF[S[SM[TW[TF[S[{=
Plan and schedule your 1 =l SPM_Project_Team0 !
project's tasks by clicking an al =
itern below. Clicking an iterm -
displays toals and instructions
for completing that step. Task: Develop project charter
E] Resource fist options
Define the project |
x . - i . 3 2 [0%:],Cellph 101
Define general working times 1:1:4 Filker by: ger 2 [0%],Cellphone1[1]
List the tasks in the project 11 '5_ !Resources;‘.ﬂsswgnments With Overtime v| I More Filters. .. l
. A 1.2 =R e E—
Organize tasks inta phases i oh |
T [ awailable to work ;
Schedule tasks More Filters
: 1232 Add Resources w
Link to or attach more task |
information 123 Resources fram Exercisel Fiters: (Task (%) Resource
Add columns of custam 124 Cellphona1 Al Resources - Hew...
Infavmetin 125 Resource Name RiD Eﬂ:?été:t?ruﬁ;
tSaestkt;Ieadllnes and constrain 126 hall Cost Overbudget
127 v D Created After..,
Identify risks to the project = v | Laptopl Date Range. ..
y 128
Add documnents to the project = ¥ |PDAL IGanI;urglglrless pssignments _
S T ; L
Publish project information to ] ¥ |Froject Manager 1 Linked Fields
the web 131 | | Non-budget Resources -
1311 iOveralocated Resources =
after planning your tasks, you 1312 Eesource Ragget.‘.
can go to the Resources area 1 Resmurces ik Mni il 3
to build your project's team 1313 CSOUICES » uaetia
and assign people to tasks.
131 Hold down Chrl and click bo select m
1.31.5 Highlight Apphy Cancel
1316 Clazgout - - o
1317 Falaasa 1 rn : : =
EES ¥

Ready

B 7 &) in0zam

—
‘4 start (B Microscft Project -E... 1_Lab01_Mant...

4.7 LEVELING RESOURCES

Navigate to Task->tools->Level Resources. Please check the Exercise for the leveling Resources.
4.8 Exercises-2

4.8.1 Assigning Human and Material resources to tasks

Task No

Human Resources

Material Resources

Column 0 Column 1

Column 5

Column 6

1

11

111

Project Manager 1

Laptopl, PDA1,Cellphonel

1.1.2

Project Manager 2

Laptop2, PDA2,Cellphone2

(620 I~ NOSE N \V)

1.1.3

Project Manager 2, System
Analyst 1

Laptop2, PDA2,Cellphone2,
Laptop3, Cellphone3

114

System Analyst 1, System
Analyst 2

Laptop3, Cellphone 3, Laptop4,
Cellphone 4

115

Project Manager 1, Project

Laptopl, PDA1,Cellphonel,
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Manager 2 Laptop2, PDA2,Cellphone 2

8 1.2

9 1.2.1 Project Manager 1 Laptopl, PDA1,Cellphonel

10 1.2.2 Project Manager 1, System Laptopl, PDAL,Cellphonel,
Analyst 1 Laptop3, Cellphone3

11 1.2.3 System Analyst 1 Laptop3, Cellphone3

12 1.2.4 System Analyst 2 Laptop4, Cellphone4

13 1.25 System Analyst 1, System Laptop3, Cellphone3, Laptop4,
Analyst 2 Cellphone4

14 1.2.6 System Analyst 3 Laptop5, Cellphoneb

15 1.2.7 System Analyst 2, System Laptop4, Cellphone4, Laptop5,
Analyst 3 Cellphone5

16 1.2.8 Project Manager 1 Laptopl, PDA1,Cellphonel

17 1.3

18 131

19 1311 Project Manager 1 Laptopl,PDA1,Cellphonel

20 1.3.1.2 Developer 1, Developer 2 Desktopl,Desktop2

21 1.3.1.3 Developer 2, Developer 3 Desktop2,desktop3

22 1.3.14 Developer 3 Desktop3

23 1.3.15 Developerl, Developer 3 Desktopl,Desktop3

24 1.3.1.6 System Analyst 1 Laptop3,Cellphone3

25 1.3.1.7 Developer 1, Project Manager | Laptopl,PDA1,cellphonel,Desktopl
1

26 1.3.2

27 1321 Project Manager 1 Laptopl,PDA1,Cellphonel

28 1.3.2.2 Developer 1, Developer 2 Desktopl,Desktop2

29 1.3.2.3 Developer 2, Developer 3 Desktop2,desktop3

30 1.3.2.4 Developer 3 Desktop3

31 1.3.25 Developerl, Developer 3 Desktopl,Desktop3

32 1.3.2.6 System Analyst 1 Laptop3,Cellphone3

33 1.3.2.7 Developer 1, Project Manager | Laptopl,PDA1,cellphonel,Desktopl
1

34 1.3.3

35 1.4 Project Manager 2 Laptop2,PDA2,Cellphone2

36 15 Project Manager 1 Laptopl,PDA1,Cellphonel
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4.8.1.1 Enter the list of resources

B Mi t - Exercisel E]

Eile Edit Wiew Insert Formak  TIsols  Project  Report  Collsborate  Window  Help

osoft Proj

Type a question for help = & X
HR =™ W= W SRE N B ORI - S & | @ gie @ + = ghow- | Aral + 8 + | B I U |w= e
=] @2 | 85 | NewResource From~ | S8 & SL | r 84 | T | %y
:[= | Tasks ~ ||Resources! ~ | Track ~ | Report = =
Project Manager 1
€& | Resource Name Intials Type | Email dddress | wWindows Lser Account | Group | Standard Rate | Owertime | ~
Rt
3 work | FO.00M | F0.004r Ji
£k [ Wiark 310,00/t $0.00hr
s Wiark $0.00hr | $0.00hr
= Wik $0.00hr | $0.00hr
S Wik $0.00hr | $0.00hr
[ Wik $0.00hr | $0.00hr
[ Wiark | $0.00hr | $0.00hr |
[} ol | $0.00Mhr | $O0.00Mr |
L Material | $0.00 |
L Material | $0.00
L Material $0.00
L Material $0.00
L material $0.00
Pl Material $0.00
P Material $0.00
| material $0.00
c Miaterial | $0.00
C Material | F0.00
[ Material F0.00
C Material | | $0.00
O Material | | $0.00
D Material $0.00
D Material $0.00
B
=
| B

t] File Edit Wew Insert Format Tools  Project  Report  Collsborate Window  Help Type a guestion for help = & X
N = IS - R AN R 3 4 9 @ = Show- | arial SR | T 2
il ‘fa Mew Resource From ~ @ %-, (5‘; E5:} ? Sd T ?ﬁ =
(5 Tasks ~ Resources ~ | Track ~ | Report
@ @ Specify Resources $% | | ResourcelMame | Intials | | Email Address  Windows User Accourt | Group | Stendard Rete | Overtime | ~

= Rate
Do you want to: i Resource Information i =
O Add resources from General Costs Notes ] Custam Fields 150000 | $0.00Mr |
Project Server {
O e : s 0oun
(3 Add resources from the Cost rate tables $75 000 $0.00Mr
company dirsctory I For rates, enter a value or a percentage increase or decrease from the previous rate, Far
() Enter resources manually 3 instance, iF a resource's Per Use Cost is reduced by 20%, bype -20%., $0.00hr | 0004
Cione |0 A (Defaul) | B c | ] | E | §O.00h | $0.00Hr
$200.00
Xl fﬁﬂm!h i s $200.00
fective Date S;aorllog;h Rate .;)Dvleorot}n':g ;ET_DL;E Cost = $200.00
$200.00
$200.00
| $75.00
- $75.00
$50.00
Cost accrual: ‘[PW $50.00
$50.00
$50.00
Details... ] [ a4 J [ Cancel $50.00
$100.00
F100.00
Desktop3 D Material | $100.00
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File Edit View Insert Format Tools  Project  Report  Collsborate Window  Help Type a guestion for help = & X
0S50 h
‘-§ L:r‘? Mew Resource From ~ @ E}g = E% ] ? 94 T ’5 =]

Resources ~ | Track -~ | Report = _
i

A =% 4 = Show= | Arial ~8 ~ B I U | v= e

Resource Name | Initials | Email Address  Windows User Account |

Group | Standard Rate : Overtime Rate |
Resource Information £|

@ @ specify Resources X

i1 50 N F200 Ol |
f150.00Mr $200.00Mr
$75.00Mr 35 00hr

Do you want to:

(O Add resources from = General Costs Notes | custom Fields
Project Server

add resources from the __‘ Resource Name: |Develnper 1 | 75 00 $95 00

Somp Ty drlne s Dol ] $75.00mr $95 00/

Add resources from the g Cost rate tables

company directory

= For rates, enter a value or a percentage increase or decrease from the previous rate, Far F60 00dr $0 00
Enter resources manually g instance, iF a resource's Per Use Cost is reduced by 20%, bype -20%.,

0 0 Q0

$60 .00 $0.00mr

Done A (Defaul) | B | c | D [ E | $200.00
= $200.00
[ %L geojooh

|Effective Date | Standard Rate Overtime Rate Per Use Cost |E S2UL00)

$e0.00/h $80.007h 40,00 = $200.00
$200.00

$75.00
$75.00
$50.00
$50.00

Cost accrual: | Prorated $50.00

$50.00
[ b | [ oetals.. | [ ok ][ cancel | :2222
$100.00
$100.00

&

@ Eile Edit  Wiew Insert Formak  Tools  Projeck  Report  Collsborate  Window  Help Type a question For help -5 X
=™ AN R IR - RREEHC - H o o+ — Show~ | Arial 8 | B o o B
T € | 38 | NewResourceFrom >~ | 3 Fh 9L ) Zr gl T | g o
- | Resources ~ | Track ~ Report = &=
Tasks - - - -
= dsource Neme | Intisls | Type | Email Address | Windows User Accourt | Group | Standerd Rete | Overtime Rate | |
Project Manager 1 P ‘ark i | §1S000ke $200.000r| =
Project Manager 2 P Wk | | $150.00hr $200.00hr
System Analyst 1 = Wiork F75.00Mr F95.00Mr
System Analyst 2 5 Wik 375 00hr $95 O0hr
Zystemn Analyst 3 = Whiork F75 00Mr F95 00
Developer 1 [ Wk F60.00Mr FB0.00mr
Developer 2 o ark | | $60.00Mhr $a0.00ihr
Developer 3 o Wark | | 360.00hr $a0.00ihr
Laptond L msterial | | $200.00
Laptop2 L Material $200.00
Laptops L Material $200 00
Laptopd L Material $200.00
Laptops L Material | | $200.00
PO Pl Material $75.00
PDA2 Pl Material | | §75.00
Cellphane? c Material $50.00
Cellphone2 s Material $50.00
Cellphone3 L3 Material F50.00
Cellphoned C Material $50.00
Cellphonss C Material | | $50.00
Desktopl D Material | | $100.00
Desktap? D Material $100.00
Desktop3 o Material $100.00
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4.8.1.3 Assigning each resource to the task

Edit  View Insert Format  Tools Project  Report  Collsborate  Window  Help Type a question for help = & X
s =™ W S N R @ % 4 = show- | Aral -8 ~| B Ir O v .r.
i S8 | 50  nMewResource From v | B Wh FL Ta, &
- | Resources ~ | Track - Report = =
Develop project charter
WES  |Task Name Duration |r|  Start | Finish Predeces 1,10 [Octir, 10 [Oct 24,10 [Gct 31,10 Mov 7,10 b
e | A5 | T IE s sm[T wW[T[F[s|SM[T[W[T[F[S|S[M[T[W[T[F[S|s[M][T MW[T[F[=
il S,D_P_n:r_:ir:::l Task Information @
General ] Predecessors Resources ] Advanced 1 Motes ] Custom Fields ]
_ nager 1
1Al TEa Mame: |DEVE‘DD project charter ‘ Duration; |5‘:| 3! [C]Estimated =
Besources:
1 1: Ef;:l: _i‘j_:t_f,l'_Prn_]_ect Manager 1 = = == .._. _.l
! Resource Marme | Assignrent Cwner | Units Cosk |
12| EiRrelectH | Project Manager 1 ¥ 100% $6,000.00 T Lo
121 Devel PDA1 ~ | F
122 Devel [ Ti
123 Crevel
124 Devel Projeck Manager 2
125 Devel System Analyst 1 =
126 Dewvel
127 Crevel
125 Projec
1.3 Project
134 =l Relea)
1.3141 Arl
1312 b
1313 ot
1314 “alidation pt 12 days & Med 1026011 | Thu 2A0M11 21
G B Deployment Sdays & Fri2A1M1 Tue 2M5M1 22
1316 Closeout 1 day & \Ned 2A6M1 “ed 2MEM1 23
A Release 1 C Oclays & “ed ZMEMT Ned 2ME6M1 24
132 ElRelease2 | 30days #hu2A7/11 fed 330111
1.3241 Analysis phs Qdays A Thu 24711 Tue 34 M1 18 s

|
B
|

Format  Tools Project  Report  Collsborate  Wwindow Type a guestion for help
Calendar == S8 = Show = | Arial =6 Sl EE e i
v | Gantt Chart
= e e g o
Metwork, Diagram =
Task Usage | — =
Tracking Gantt
Resaurce Graph [ &
Resource Sheet
S |Task Mame Durstion Stert | Finish |Predecessors |Resource Names
@ DTasks Resource Usage
Plan and sche 1 = SPM_Project_Teamb 188 days zd 10413410 | Fri 741111
LaNtE Sl Mare Views. .. | & sk | J| oH | | — |
E . 1.1 Project Initiation 103 days >d 10M340 Fri 31411 Project 100
T H » 1 .
displays toals EDSHED 144 Develop project charter 5 days 'ed 104310 ue 104940 Project Manager 1 ,Cell laject Manager 1.4
for completing) Toolbars 112 Develop Statement Of Worl Odays ue10/19M0 ue 104910 3 Project Manager 1 [0%]| 049
Define the pro| fo1  Turm OFF Project Suide 113 Develop prefiminary scope O days ‘=d 10/ 3110 Von 2/28M1 |4 Project Manager 1 [0%]|
Sefinsaan ra i e 114 Develop prefiminary archite 4 days |vion 2281 | Fri 311 |5 | System analyst 2 Proj:|
: i 118 Project inftistion complete Odays FriSimil  Frsmil 3458 |
List the tasks i (3 Show Change Highlighting 1 . | | 1
PSS 1.2 Project plan 97 days | 1e 10/26/10 Wed 3/9/11 o=
Header and Footer... i i i
e H 124 Develop scope managemer ey | Fri 31| Mon 371 2 | Praject anager 1 Proj|
Lo zaam... 122 Develop chenge mansgeme  Odays  Fri3iaf1 | Frisiini |2 |Praject Manager 2 [0%]|
infarmation 123 Develop intial descriptive b 0 days | ue 10/26/10 | ue 10/26M0 Project Manager 2 [0%] =T
add columns of customn 1.2.4 Develop schedule Odays hon 371 hon 371 |3 Project Manager 2 [0%]
infarmation 125 Develop guality managemer 2days  Won S7A1 | Tue 3811 2 System Lnalyst 3
tsaitk:ead"”ﬁ and constrain 126 Develop human resource p. O days | hon 37A1 | Mon 3741 @ Project Manager 2 [0%]
s e | 127 Develop risk management 2 days | Tue 36511 | Wed 36119 | Project Manager 2
128 Project pi let 0d wied 39711 | wed 3/8M1 9,10,11,12,13,1
Add docurnents to the project | IRIDGLRIRL SOmPISe kAl i = iR b2y | |
13 ject Executi 188 d 2d 101310 Fri TAM1 —_—
Publish project information to folsr ke ton e B |
the Web 131 =l Release 1 61 days [hu 31041 Thu 6211 |
1311 Lnalysis phase 18 days Thu 3M0/1 | Mon 45411 8 System Analyst 1
After planning your tasks, you 1312 Design phase 15 days | Tue 45511 von 452541 19 System Aralyst 2
can go to the Resources area -
forb iy Sl project=te o 1313 Construction phase 12 days | Tue 426111 Wed SH1M1 |20 Developer 1
and assign people to tasks. 1314 walidetion phase 12 deys | Thu SA2M1 | Fris@ent | 21 Developer 2
1315 Deploymert phass 3 days vlon 5/30/1 | Wed BMM1 |22 Developer 3
| 1315 Clossout 1day ThuBA1| ThuBizd1 23 System Analyst 1 Syst
ETE: [ R ——— A reve | Tho BPA | T Boaa (e |
| 3| (i) (il

Ready

‘4 start =i | 1_Laboi_w e F 91_Lab01_Manu,.. B T & 1044 8M
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4.8.1.5 Dealing with over allocated Resource

Navigate to task->Assign Resources

Exercisel

File Edit Wew Insett Farmat  Tools  Project  Report  Collsborate Window  Help Type a guestion for help - f X
INEH &R  Ba@m 9-o - & sc.“" F = Show = | Arial -8 ~| B r o ;?.
Mew Resource From @ ?a =
_23 ioz Ez 100 ﬂl‘ 3 % B
DE0EE®E.
~ Resources = Track =~ | Report -
Tasks
(@ @ Specify Resources 4 | _ Resource Name Start | Initimls | Type Email Adoress | ¥Windows User Account | Group | Standard Rate Dwvertime Rate
m Project Manager 1 Wied 1013410 P Wark $150 00 $200 000 =
Do you want to:
&> | Project Manager 2 Wed 10/13/10 P Work $150.00hr $200.00/hr
(@] Qfﬂdje";sg‘;:ﬁi from 3@ System Analyst 1 Thu 31011 s Work $75.00/hr $95.00/hr
®) Add resources from the 4 System Analyst 2 Tue 3MM1 | S. Wiark $75.00Mr $95.00Mt
company Address Book z System Analyst 3 Mon 3711 s ‘iork $75 .00 $95.00he
b gfnd_‘;:?‘?r“gﬁ’?cgs;” the & Developer 1 Tue 4726111 | ol iiark F60.00/H | $60.00/H
7 Developer 2 Thu 5112011 ) Wik $60.00Mr $50.00Mt
() Enter resources manually { ! 1 !
Developer 3 Mon 5530011 o Wiork F60.00Mr £50 .00t
Dione E Laptopt Wied 1043410 L Materisl $20000
10| Laptop2 MA L Material $200.00
Laptop3 A L Material $200.00
Laptopd Whied BSA1 | L Materisl $200.00
| Laptops | Ll Material $200.00
14| PO Wed 10413110 Pl Material $75.00
15| POR2 HA Pl Material $75.00
18| Cellphonet Tue 3AM1 | c msterial $50.00
17| Celphane2 A c Material $50.00
18| Celphone3 T, G Material $5000
13 Cellphones P2, C o Material 50,00
20| Cellphanes ma | C Material F50.00
21| Desktopl P D haterial $100.00
2z| Desktop2 A D Material F10000
23| Desktop3 A [} Material $100.00

Eile Edit Wiew Insert Format | Tools | Froject  Report  Collsborate  Window  Help Type a question for help |~ & X
' Speling... F7 i % 4 = Show~ | Arial -3 ~|B|lr U |w= i
AutoCorrect Options. ..
BacUmentMaragamant =
Links Between Projects. ..
_ Import Outlook Tasks...
id |/Tasks - | Resources v | Track -
Change Working Time. ..
1
@ © Tasks SR R = SRS Du 7,1 Mar 5, 11 Mar 13, 11 Mar 20, 11 Mar 27,11~
Build Team from Enterprise...  Crr+T T[T IF[S[SM[T WIT[F[S[SM[T[WIT[F[5 S[M[T[W[T[F[S[SMT W
Plan and schedule your - 181 1 5
project's tasks by clicking an Substituts Resources... o
itern below, Clicking an itern Lacal P t Cach 5 b b
displays too_ls and instructions acal Erolect Lachs er L
for completing that step. Reecircoshanng 5 Fevv
Define the project Ll Senurcen, =R s
e Anetal v Ve T , Brohite _l Analyst 2 Project Manager 1 [0%],Project Manager 2 [0%],Cellphon
List the tasks in the project | Vet T Iste | & |3
o 101 |
Organize tasks into phases . | -+ b
Sk e Organizer... cismEr G- Projec 1 Project Manager 2 [150%]
= PG
Link to or attach more task Qustormize peppoci e
information options. .. ptive b
add columns of custom ) )
e Enterpriss Options A imta
?aitkgead“nes and constrain 14 1.26 Develop human resource p
g 127 Devel k it roject Manager 2
Identify risks to the project = E\TE ST TR R Sml 3
Add documents to the project = 128 Broleckpien complels *
1.3 = Project Executi 181
Publish project information to y folnet leonfion [
the weah 15 1.3 =l Release 1 6 |
19 1339 Analysis phase 1
after planning your tasks, you S B EEE] P —— i
can go to the Resources area : - |
to build your project's team 21 1343 Canstruction phase 1
and assign people to tasks. 22 1.3.1.4 walidation phase 1
23 1315 Deployment phase
24 | 1318 Clozeout w
25 4347 Falazra 1 Comelats =
i ) |l 9

Ready
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File Edit “iew Insert Formak  Tools  Projeck  Report  Collsborate  Window  Help Type a question for help -5 X
= W - N R =8 = B | @ H % & = show=- | Arial -8 ~|Blr o|v E
i 88 | New ResourceFrom = | SB ¥ 9L | W o7 &4 | T "55.
e EEREET 2 R
MEEBE®BL
Mar‘iS ;11 Mar?l:l,;ﬂ Mar??,;ﬂ ~

Task: SPM_Project_Teami
B Resource list options

@ @Tasks

Plan and schedule yvou
project's tasks by clic
itemn below, Clicking a
displays tools and inst
for completing that stel

r 6,11 3
W T W [T (F (S SM[T WI[T[F[S S [M[TW[T[F[S|5[M[TW

Filter by:

|Overa||0:ated Resources

Vl More Filkers, ., |

Define the project A
B ofine ansral workin Fiters: () Task (%) Resource Analyst 2 Project Manager 1 [0%].Project Manager 2 [0%],Cellphon:
List the tasks in the pr DalsRangers ] M.
£ : Group... =
Organize tasks inta ph In Progress Assignments [ EHE ] : )
Schedule tasks Linked Fields il rojec 1 ,Project Manager 2 [150%]
Mon-budget Resources
Link to or attach more Herludaet Bessurcer, ;
infarmation Resource Range. .. - 1
L
Add columns of custon Resources - Cost 34
inforrmation Resources - Material i 3
s Resources - Work | Hel o I
tSetkdeadllnes and eon Resaurces With Attachments =i
Bk Resources/Assignments With Overtime 2
roject Manager 2

Identify risks to the p SEOUE Start By, % = :”gl g
add docurnents to the Should Start/Finish B, == k4
Publish project inform
the web [ Highlight ] L Apply J [ Cancel ]
After planning your tasks, you 1312 Design phase 1
can go to the Resources area !
to build your project's tearn | 1313 Construction phass 1
and assign people to tasks. 1314 walidation phase 1

% b B b4 Deployment phase

1316 Clossout o

117 [ R S—" =]

%

After clicking apply button. Again Navigate from tools->Assign Resources to display which
Resources are over allocated

File Edit Wew Insert Format Tools FProject  Report  Collsborate  Window Help Type a question for help = & X
E =™ = - S RE T - S B R == A & % 4 = Show~ | arial >8 ~ |l r o |w= B
H &8 | 55 | NewResource From -~ 2 W 9L
N HSESEEESEES AR
FlF B E e E
(5 ||Tasks - | Resources - | Track - | Report  ~
1
@@Tasks = | WBS |TaskName ‘ Du 71 Mar 5, 11 har 13,11 hiar 20,'11 hdar 27,'11 ~
| T[T [F[S[S[M|TMITF[S|S[M[TW[T[F[S|[5[M[T["W[T][F[S[S[M[T [
Plan and schedule your 1 -EI SPM_Project_Team0 181
project’s tasks by clicking an —— =
itern below, Clicking an itermn A I
displays tools and instructions 3 e eED LT e
e e s A 4 | || Task: SPM_Project_Teamn
e e 5 [=] Resaurce list options
BeTe e e 5 e hanager 1 [0%],Project Manager 2 [0%],Cellphon:
—— ilker by
: : T =
List the tasks in the project = [Overallocated Resources ~| [ More Fikers, .. ]
Crganize tasks into phases
ol e g [ Awailable to work.  (0h JProject Manager 2 [150%]
-
Link to or attach more task Add Resources
Inforenatinn " | | Resources from Exercise1
Add columns of custom 12 r T ;
information NN FrojsctManager2 T Assian =~
: : | |Resource Mame |RJD Units Cost |
Set deadlines and constrain — =
s  [Project Mania er 2
System A b1
Identify risks to the project } Rl St e
Add docurnents to the project [
Publish project information to |
the web |
|
After planning your tasks, you I
can go to the Resources area
to build your project's teamn |
and assign people to tasks. | | )
Hold down Ctrl and click to select multiple resources
TS TSI ] B
75 12T FBolaasa 1 Comnlata — |
i v
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H i.iﬂl File Edit View Insert Format  Tools  Project  Report  Collsborate Window  Help Type aguestionforhelp = @ X
N EH &R G290 =50 @ - +# = Show= | Arial 2] B 7 U | B
EHE a8 & | New Resource From = @ E_it; 9@ EEs T ?s g
LY
if L=
5 | Tasks = Resources ~  Track ~ | Report - =
Rezource Name Start Initials Type | Email Address Wyindowrs User Account | Group Standard Rate | COvertime Rate | ~
Project Manager 1 Wed 101310 P Work | F150.00Mr $200.00Mr =
Project Manager 2 Wed 101310 [ Work $150.00/hr $200.00/hr |
System Analyst1 | Thu 34041 | 5| Work | $75.00r | $95.00/hr |
System Analyst 2 Tue 3141 | s Work | $75.00mr $35.00/hr |
System Analyst 3 Mon 371 s ok | 75 00mr | $95.00mr |
Developer 1 Tue 4/26M11 [+ Work F60.00Mr FE0.00Mr |
Developer 2 Thu 5112411 ] Wwiark $60 .00 $80 00|
Developer 3 Mon 5530414 | o Wiork | $60.00mr | $30.00/0r |
Laptopt Wed 101340 L Material| $200.00 |
Laptop2 M L Material §200.00
Laptop3 M L Material $200.00
Laptopd Ved BB | L Material| $200.00
Laptops A L Material $200.00
PDA Wed 101310 Pl Material| $75.00)
POA&Z na Pl Material $75.00
Cellphonet Tue 3141 i Material $50.00
Cellphone2 ey C Material| $50.00
Cellphones A [ Material $50.00
Cellphane# 'y C Msterial $50.00|
Cellphones Ry C Material| $50.00
Desktop1 M& [+ Material $100.00
Desktop2 ey D Material| $100.00
Desktop3 A D Material $100.00
it
=
H

i Insert  Farmat Project  Report  Collsborate  Window  Help Type a question For help [~ &

& (A G | 9 - |V speling.. F7 @b = shoiic | erial =iy B 7 U |v= ]

85 | v Resourea AutoCorrect Options. ..
T T Document Management
£ = = = —
& = Links Between Projects. ..
= Import Outlook Tasks...
Tasks =~ | Resources - | Track -
Change Waorking Time...
System Analyst
- € Assign Resources... Alb+-F10 - - -

Resource Name | =t | Windowws User Account Group | Standsrd Rate | Overtime Rate Lo
Project Manager 1 | Wed 1| [£2 Buid Team from Enterprise...  Ctr4+T $150.00/hr $200.00/hr =]
Project Manager 2 | Tue 1| 28  substituts Resources.., $150.00/hr $200.00/hr
System Analyst 1 Thu b e e i $75.00/mr $95.00/hr

-
System Analyst 2 Tu e i $75.00/0r | 335,004 |
System Analyst 3 Mo F75 00Mr F95 .00Mr
Developer 1 Tue L PR $60.00MF $80.00/r |
Developer 2 Thu Tracking > FE0.00hr $80.00Mr
Developer 3 Mon Macra » $E0.00hr $50.00/hr |
Laptop1 Wied 1 e F200.00
Laptop2 $200.00
Laptop3 Ctistomize, s $200.00
Laptopa Wi Options. .. $200.00
Laptops Erterprise COptions v $200 00
PDA1 Wieel 1 IFTIFATD 1 TASTEFTET $75.00
PDAZ [y P Wisterial $75.00
Cellphonet Wed 1013410 C Material F50.00
Cellphonez MA c Material $50.00
Cellphone3 MA c Msterial $50.00
Cellghoned MA c Wisterial $50.00
Cellphones NA C Material F50.00
Desktopl el 10134 0 [ Material $100.00
Desktop2 M [ Wisterial $100.00
Desktop3 [SFLY s} Material F100.00
-
=
(2%

/4 start

_Labo1l_Manu...

1_LabOl_Manu...

10:47 AM
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File Edit View Insert Format  Tools  Project  Report  Collsborate Window  Help Type a question for help = @ X
al= 4| @

B | 5 NewResowceFron - B P 9L 01 47 6| T 7g o
e T e Y.
FEEDESEL

Tasks -  Resources - | Track - | Report T s

A = 4 = Show- | Arial ~8 ~ |EEl S O |¥= i

a | Resource Name | Start | | vertime Rate
I3 Project Manager 1 | Wed 1011310 Leveling calculations $200.00/hr
ko3 Project Manager 2 | Tue 10/26/10 ) Aukarnatic Eanual $200.00/hr
to3 Thu 314041 Look For overallocations ona | Day by Day | basis $95.00/hr
System Analyst2 | Tue 31411 lear leveling values before leveling $85.00Ar
System &Analyst 3 Mon 371 7 i $85.00Mr
| ! Leveling range for ‘Exercisel
Developer 1 Tue 412601 . . $a0.00Mhr
T @ Level entire project
Developer 2 Thu 512411 FE80.00Mr

I T s [Wed 1013710

Laptop2 M Resolving overallocations
Laptop3 MA
Pl 1 : Leveling order: Standard w
Laptopd Wed B/
- - [l Level only within available slack
Laptops Ma
. . eveling can adjust individual assignments on a task,
FDA1 Wed 10/ 310
+ Leweling can create splits in pemaining work
EDA2 ] [(Level ith th d booking b
1 1 evel resources with the proposed bookin =
Cellphonet Wyed 101310 B S
Cellphane2 | A eling. .. Level Now ] [ o3 ] [ Cancel ]
Celphoned Ma
Cellphoned MA £} Material $50.00
Cellphones M (5] Material $50.00
Desktopt Wigd 101340 5] Material F100.00
Desktop2 M o Material $100.00
Desktops MA ] Msterial F100.00

cBzi| File Edit Miew Insert  Formak  Tools  Projeck  Report  Collsborate  Window  Help Tvpe a guestion for help -5 X
N EH &R G 9@ = 8@ P 9 4 = Show=- | Arial 6 =|EElor w | B
i | @ | 98 | New Resource From~ | B P L | [ R &4 | T | 79 -

: Bietal®p

-  Resources ~ | Track =  PReport |

Resource Name | Start | Initials: Type Email Address | Windows User &ccourt | Group | Standard Rate | Overtime Rate
Project Manager 1 = Wed 101310 P Work $150.00/hr $200.00/hr =
Project Manager 2 | Tue 1072610 Pl Work | $150.00/hr $200.00/hr

Thu 31011 5 Work $75.00Mmr $95.00/hr
System Analyst 2 Tue 3141/ 5 Wark | | 75000 $95.00hr
System Analyst3 | Mon 37A1) 5| Wiark | | F75 00/ | $35 00hr
Developer 1 | Tue azBA1 | o | | $50.000r | $80.00hr
Developer 2 | ThusAza o F60.00hr $60.00mr
Developer 3 | mon 5P0M1 o - $50.000r $80.00Mr
Laptopt | Wed 10M 340 L O $200.00
Laptopa A i () selected resources $200.00
Laptop3 | [y L $200.00
Laptaps Wi BIRH 1 L waterial $200 00
Laptops | iy L Misterial| | $200.00
POAT Wi 10M 30 P Material F75.00
POAZ | hA, P Wsterial | $75.00
Cellphonet Wed 101310 [ Material £50.00
Cellphone2 | ey C Material| | | $50.00]
Cellphone3 A [ Material $50.00
Cellghoned | M| C Material| | 350,00
Cellphones A [ Material £50.00
Desktopl | wed 1030 D Material| | $100.00
Desktop2 | M| D Material| | F100.00
Desktop3 | M D Material | $100.00
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File Edit View Insert Format Tools  Project  Report  Collsborate Window  Help Type a guestion for help = & X
=A™ W2 NS NN R SRR - Wi=si- N S = show= | Arial -8 B 7 U v i
i | @ | 58 | MewResourceFrom - | B Fh SL | 3 S gl | T | g El
T T Y
IOEaEME.
15 | Tasks = | Resources =+ Track = | Report -
'@ | ResourceMame | Start Intisls | Type | Email Address | Windows User Account | Group | Standard Rate | Overtime Rate | -~
1 ‘<§ " Project Manager 1 | Wed 101310 | P Work | I i  $150.00hr |  $200.00/hr | =]
2 <@ | Project Manager 2 | Tue 1012610 P Work $150.00mr | $200.00Mr |
EFTS aly Thu 31011 | S| Work| $75.00mr | $95.00mr |
3 System Analyst 2 Tue 3141 | s Wik | $75.000hr $35.00/mr |
System Analyst 3 Mon 3741 | s Work | $75.00hr | $35.00Mr |
Developer 1 Tue 412611 D Wiark | $60.000r | $50.00/r |
Developer 2 Thu 51211 o F60.00Mr $E60.00MHr
Developer 3 Mon 53011 | Dl $60.00/hr | $80.00/r |
Laptap1 VWed 1011310 L waterid ©Entire pocl oK $200.00] |
Laptop2 & L Materi @ﬁ- $200.00 |
Laptop3 Ma L Msteri; F200.00 |
Laptopd Wl GIEA1 Ll Material $200.00
Laptops ey L Material| $200.00
PDA Wed 101310 Pl Meterial| §75.00) |
PDA2 A Pl Material $75.00
Cellphaonet Wed 10A310 | | Material| $50.00
Celphone2 Ma [ Material $50.00
Cellphone3 Ma [ Material $50.00
""" Cellahaned iy C Material $50.00| |
Cellphanes 'y C Msterial $50.00) |
Desktopt Wed 101310 D Msterial $100.00
Desktopz hA | D Material| $100.00 |
Desktop3 Ma ] Material

$100.00

@ File Edit View Insert Format  Tools Project  Report  Collsborate  Window  Help Type a guestion for help - f X
F =™ W= e WREE T S BES RN R A= - e o = Show~ | Arial -8 | B 5 O | a
& t 3'_ Mew Resource From ~ 5 2 g’%__ E%] _? ﬁ-! T ,5. =]
S R SR R
AEDEEEPEL
(5 | Tasks - | Resources -+ | Track - | Report - &
Project Manager 1 |
@ @Spaci'fy Resources b4 B | Resource Mame } Start I Initials I_ '!'__\{'Ele \_Email Address !_\r’\ﬁnduws User Account ;_Gmu_;_:! :__Standard Rate | Overtime Raie_ S
IM] Wed 1013110 P Wiark $150.00mr F200.000
Do you want to: 1] -
Project Manager 2 wed 10413410 P Work $150.00hr $200.00h
o] sr‘?odjgsfgg:ii frorn System Analyst 1 Thu 3401 | s Wik 75000 | $95.00h
o Add resources from the Syatem Analyst 2 Tue 3MM1 3 Wiark $75.00Mr $95.00Mt
company Address Book System Analyst 3 Mo 371 s wiark §75.00Mr $95 .00
0 ggn‘ig:i;“gﬁzg;ﬁ;” the Developer 1 Tue 4726111 | o iark $60.000r | $50.00M
O ErtrppecSae s ls Developer 2 Thu S 2M1 | D. Work 'BEEI.EIEI.fhr. F80.00M:
Developer 3 Won 5£30411 ) Work $60.00Mr $50.00Mt
Done Laptopt wed 10413410 L Material $200.00
Laptop2 A L Material $200 00
Laptop3 A L aterial $20000
Laptopd Ved BEMT | L Material $20000
Laptops A L Material $20000
PO Wied 1043410 P Materisl $75.00
PDA2 A Pl Material $75.00
Celphonet Wed 101310 2 Material $50.00
Celphone2 M| c Material $5000
Cellphoned Ma 24 Material F50.00
Cellphoned R o Material F50.00
Cellphones P2, C Material 50,00
Desktopl Wed 1041340 D Material $100.00
Desktop? A o] Material $100.00
Desktops A o] Material $100.00
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4.8.2 Gantt Diagram with Resources Assigned
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4.8.3 Network Diagram with Resources Assigned
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4.8.4 Assigning Resource Availability
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5 PRINTING AND FORMATTING THE PROJECT INFORMATION

5.1 Using a GANTT CHART

To View the Gantt chart Select ->view -> Gantt chart
To Modify Select Format->Timescale for the output to be displayed in min, hrs, weeks, thirds of
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5.3 Using the GANTT CHART Wizard
Navigate to Format->Gantt Chart Wizard
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5.3.1 Setting the Critical Path
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5.5 Displaying Task Completion

The completion of the task is selected by Double-Click on the task name-> using the Percent
Complete Field in task information.
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5.6 Formatting the Progress Lines on the GANTT CHART

& Microsoft Project
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5.7 Using Predefined Reports

Navigate to Report->Reports
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Click on Overview & click on select button as shown below
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5.7.1 Overview Report
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Exercisel

asofhon 1041410

Dates

Start: Med 1051210 Finigh: Fri7ism
Baseline Stan: NA Baseline Finish: HA
Actual Start: Med 101310 Actual Finish: NA
Start “ariance: 0 days Finish “arianee: 0 days

Duration

Scheduled: T8E days Ramaining : 185 06 days
Baseline 0 days? Actaal: 294 days
‘ariance: 188 days Fercert Complete 2%

i o

Scheduled: 2,483 hrs Remaining : 245075 hrs
Bazeline 0 hrs Actal: 3T Ifihrs
“ariance: 2,488 hrs Percent Complete 1%

Costs

Scheduled: F208,765.00 Remaining : F303,121.67
Bazeline F0.00 Actaal: $5.642.33
“ariance: $308,765.00

Task Status Rezource Status
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5.7.2 Assignment Report
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5.8.1 Selecting the Report to use
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5.8.2 Defining New Report
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5.8.3 Defining Options for the Resource Report
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6 ASSIGNING COST INFORMATION TO A TASK
6.1 Determining Pro

ect Cost
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6.3 Determining the Cost Variance
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6.5 Determining the Remaining Cost
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7 TRACKING PROGRESS
7.1 Planned Versus Actual Amounts
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To compare the variances among planned and actual for the time on the project.
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7.3 Tracking the Actual Hours Worked

Eile  Edit | ¥iew Insert  Farmat Tools Project  Report  Collaborate  Window  Help Type a question for help = @ X
Calendar @ w4 = show- | Al w8 =|BE.r o= 2
Gantt Chart é; |y el | T ?ﬁ. -
Metwork Diagram %
Task Usage | — =
Tracking Gantt
Resource Graph LE.-
Resource Sheet = =
Resoiiea LSags inish % Comp. Phys. % Act.Dur. | Rem. Dur Act. Cost 20, 11 Feb 27,11 Mar B, 11 War 13, 11 Whar 20, 11 ar
= | (S| | I TTFSIEMTIMTFSSMTIMTFS[SMTIMTFISISMTIMTFSSMT =
More Wiews. .. 2% 0% 2.94 days 85.06 days  $5,643.33
Table: Tracking v o 117 days 8583 days | $1,865.83 ] =
5 1.5 days 3.5 days 1 ,522.50
Lo ' ELR, Odays  Odays 5000 T
Turn OFF Project Guide Hypetlink. o days. Odays $0.00 LT
Wiew Bat Schedule 0 days 4 days $0.00 £=il Analyst 2 Project Manager 1 [0%],Proj
-
Show Change Highlighting Summary O days Odays $0.00 & |3
0 days 106 days $0.00
i Header and Footer... ¥ | Tracking : : t i
9 = O days 1 day $0.00 1 Project 2
10 Zoom. . Hsage Odays  Odays 50.00
11 Develop initial T, Yariance 0 days 0 days F000 -
12 Develop schec Ma, work, 0 days 0 days $0.00 P 4
13 Develop guslits (RS More Tables. .. Odays 2davs F0.00 Analyst 3
Ak | Develop humai (RS Odays Odays F0.00 I
15 Develop risk m P M 0% 0% O days 2 days $0.00 roject Manager
16 Project plan cc [ S 0% 0% 0 days 0 days $0.00 % |39
17 =l Project Executia HA HA 0% 0% 0days 188 days $0.00
18 Release 1 HA HA 0% 0% 0days  61days $0.00 =
19 Analysie pl iy [ 0% 0% Odays| 18 days $0.00 =
20 Design phs T NA 0% 0% Odays 15 days $0.00
2 Constructic (RS [RF 0% 0% O days 12 days $0.00
22 | “alickation (0% M, 0% 0% O days 12 days F0.00
23 Deploymen [ A 0% 0% 0 days 3 days $0.00
24 Closeout P, M2 0% 0% O days 1 day $0.00 E’
| 5 | B

Exercisel
File Edit Miew Insert Formak  Tools  Projeck  Report  Collsborate  Window  Help Type a question for help -5 X
Ba @ 9o~ == Ea $hR | @ ;_;‘E-F‘?+=-§huwv arial +8 ~|B|7r U |w =
New Resource From = | 6B W &L | 1) 57 & | 7 | ?g
T LY
Rl FEIH @ E a4 B g
13 | Tasks =~ | Resources = | Track =  Report - =
SPM_Project_TeamO
| Task Mame Wark | Bassline wariance | Actual Remaining | %W, Comp. 20,11 Feb 27 11 [MarE, 11 Mar 13,11 Mar 20,11 Mar 27 A
| | e | I TRTFEEMTIMTIFEEMT T FEE MTWTFEEMTWTFEEMTE —
1 2,488 hrs = 2,438 hrs Ohrs 3725 hrs 2,450.75 hrs 1% 5
2 T2hrs | T2hrs | ohrs 12hrs | S0 hrs | 17% -
~3 | Develop praject cha 40 hrs | 40 hrs | Ohrs 12 hrs| 2 hrs| 30% | ]
4 | Develop Statement Ohrs 0hrs Ohrs Ohrs Ohrs 0%
5 Develop preliminary Ohrs 0 hrs Ohrs O hrs 0 hrs 100% s 11}
B [ Develop preliminary 32 hrs 32 hrs Ohrs a hrs. 32 hrs. 0% E?l Analyst 2 ,Project Manager 1 [0%],Proje
7 Project intiation con Ohrs 0hrs Ohrs Ohrs 0hrs 0% @ |3
& | [ElProjectplan 40 hrs Mnhrs | 0hrs Ohrs | ahrs | 0% =
3 | Develop scope mar Shrs Ghrs Ohrs Ohrs Ghrs 0% - oject 1 ,Project - 2 [150
10 | Develop change ms Ohrs| Ohrs| Ohrs Ohrs| Ohrs| 0% b3
11 Develop inttial desc 0 hrs 0 hrs dhrs Ohrs 0hrs 0% -
1z Develop schedule Ohrs| 0hrs Ohrs Ohrs 0 s 0% 37
13 | Develop qualty mar 16 hrs 16 hrs | Ohrs Ohrs | 16 hrs | 0% G Analyst 3
14 | Develop human res Ohrs Ohrs Ohrs Ohrs| Ohrs| 0% T
| Develop risk manag 16 hrs 16 hrs Ohrs Ohrs| 16 brs| 0% roiect Manager 2
16 | Project plan comple Ohrs Ohrs| Ohrs Ohrs| Ohrs | 0% EL ]
17 = Project Execution 760 hrs 760 hrs 0hrs 0hrs 760 hrs 0%
18 Release 1 520 hrs 520 hrs 0hrs ohrs 520 hrs 0% &
8 | Analysis phase 144 frs | 144 brs | Ohrs Ohrs | 144 hrs | 0% - i
| Design phase 120 hrs | 120 hrs Ohrs Ohrs 120 hrs 0%
G| Construction ph 95 hrs 96 hrs | Ohrs Ohrs 96 hrs | 0%
= | “alidation phase 95 hrs 96 hrs Ohrs Ohrs| 96 hrs | 0%
23 Deployment pha 24 hrs 24 hrs Ohrs Ohrs 24 hrs 0%
24 | Clozeout 40 hrs 40 hrs | Ohrs s 40 brs | 0% i3

25 RPalaasa 1 Crme Nhes N hes Nbes N hes nhes nee | pm |




CS591 Course: Microsoft Project 2007 Lab Manual

7.4 Setting the Baseline
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7.5 The Tracking
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7.6 Interrupting work on a task
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